## Contents

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Word-Processing</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Basic Concepts</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Computer Organisation</td>
<td>10</td>
</tr>
<tr>
<td>3</td>
<td>An Introduction to Windows 95</td>
<td>23</td>
</tr>
<tr>
<td>4</td>
<td>Introduction to Ms-Word</td>
<td>39</td>
</tr>
<tr>
<td>5</td>
<td>Creating and Editing a Document</td>
<td>50</td>
</tr>
<tr>
<td>6</td>
<td>Formatting a Document</td>
<td>62</td>
</tr>
<tr>
<td>7</td>
<td>Advanced Formatting</td>
<td>76</td>
</tr>
<tr>
<td>8</td>
<td>Mail Merge</td>
<td>87</td>
</tr>
</tbody>
</table>
1 BASIC CONCEPTS

1.1 INTRODUCTION

Let us begin with the word ‘compute’. It means ‘to calculate’. We all are familiar with calculations in our day to day life. We apply mathematical operations like addition, subtraction, multiplication, etc. and many other formulae for calculations. Simpler calculations take less time. But complex calculations take much longer time. Another factor is accuracy in calculations. So man explored with the idea to develop a machine which can perform this type of arithmetic calculation faster and with full accuracy. This gave birth to a device or machine called ‘computer’.

The computer we see today is quite different from the one made in the beginning. The number of applications of a computer has increased, the speed and accuracy of calculation has increased. You must appreciate the impact of computers in our day to day life. Reservation of tickets in air lines and railways, payment of telephone and electricity bills, deposits and withdrawals of money from banks, business data processing, medical diagnosis, weather forecasting, etc. are some of the areas where computer has become extremely useful.

However, there is one limitation of the computer. Human beings do calculations on their own. But computer is a dumb machine and it has to be given proper instructions to carry out its calculation. This is why we should know how a computer works.

1.2 OBJECTIVES

After going through this lesson you will be able:

- define a computer
- identify characteristics of computer
- trace the origin and evolution of computer
- identify capability of computer in terms of speed and accuracy
- distinguish computer from human beings and calculator
- identify the role of computer in every day life
1.3 WHAT IS A COMPUTER?

Computer is an electronic device. As mentioned in the introduction it can do arithmetic calculations very fast. But as you will see later, it does much more than that. It can be compared to a magic box, which serves different purposes to different people. For a common man computer is simply a calculator, which works automatic and quite fast. For a person who knows much about it, computer is a machine capable of solving problems and manipulating data. It accepts data, processes the data by doing some mathematical and logical operations and gives us the desired output.

Therefore, we may define computer as a device that transforms data. Data can be anything like marks obtained by you in various subjects. It can also be name, age, sex, weight, height; etc. of all the students in your class, savings, investments, etc., of a country. Computer can be defined in terms of its functions. It can i) accept data ii) store data, iii) process data as desired, and iv) retrieve the stored data as and when required and v) print the result in desired format. You will know more about these functions as you go through the later lessons.

Fig. 1.1 depicts a personal computer

1.4 CHARACTERISTICS OF COMPUTER

Let us identify the major characteristics of computer. These can be discussed under the headings of speed, accuracy, diligence, versatility and memory.

(a) Speed

As you know computer can work very fast. It takes only few seconds for calculations that we take hours to complete. Suppose you are asked to calculate the average monthly income of one thousand persons in your neighborhood. For this you have to add income from all sources for all persons on a day to day basis and find out the average for each one of them. How long will it take for you to do this? One day, two days or one week? Do you know your small computer can finish this work in few seconds? The weather forecasting that you see every day on TV is the results of compilation and analysis of huge amount of data on temperature, humidity, pressure, etc. of various
places by computers. It takes few minutes for the computer to process this huge amount of data and give the result.

You will be surprised to know that computer can perform millions (1,000,000) of instructions and even more per second. Therefore, we determine the speed of computer in terms of microsecond \((10^{-6}\text{ part of a second})\) or nano-second \((10^{-9}\text{ part of a second})\). From this you can imagine how fast your computer performs work.

(b) Accuracy

Suppose some one calculates faster but commits a lot of errors in computing. Such result is useless. There is another aspect. Suppose you want to divide 15 by 7. You may work out up to 2 decimal places and say the dividend is 2.14. I may calculate up to 4 decimal places and say that the result is 2.1428. Some one else may go up to 9 decimal places and say the result is 2.142857143. Hence, in addition to speed, the computer has accuracy or correctness in computing.

The degree of accuracy of computer is very high and every calculation is performed with the same accuracy. The accuracy level is determined on the basis of design of computer. The errors in computer are due to human and inaccurate data.

(c) Diligence

A computer is free from tiredness, lack of concentration, fatigue, etc. It can work for hours without creating any error. If millions of calculations are to be performed, a computer will perform every calculation with the same accuracy. Due to this capability it overpowers human being in routine type of work.

(d) Versatility

It means the capacity to perform completely different type of work. You may use your computer to prepare payroll slips. Next moment you may use it for inventory management or to prepare electric bills.

(e) Power of Remembering

Computer has the power of storing any amount of information or data. Any information can be stored and recalled as long as you require it, for any numbers of years. It depends entirely upon you how much data you want to store in a computer and when to lose or retrieve these data.

(f) No IQ

Computer is a dumb machine and it cannot do any work without instruction from the user. It performs the instructions at tremendous speed and with accuracy. It is you to decide what you want to do and in what sequence. So a computer cannot take its own decision as you can.

(g) No Feeling

It does not have feelings or emotion, taste, knowledge and experience. Thus it does not get tired even after long hours of work. It does not distinguish between users.

(h) Storage

The Computer has an in-built memory where it can store a large amount of data. You
can also store data in secondary storage devices such as floppies, which can be kept outside your computer and can be carried to other computers.

**IN-TEXT QUESTIONS 1.1**

1. What is a computer? Why is it known as data processor?
2. What are the important characteristics of computer?

### 1.5 HISTORY OF COMPUTER

History of computer could be traced back to the effort of man to count large numbers. This process of counting of large numbers generated various systems of numeration like Babylonian system of numeration, Greek system of numeration, Roman system of numeration and Indian system of numeration. Out of these the Indian system of numeration has been accepted universally. It is the basis of modern decimal system of numeration (0, 1, 2, 3, 4, 5, 6, 7, 8, 9). Later you will know how the computer solves all calculations based on decimal system. But you will be surprised to know that the computer does not understand the decimal system and uses binary system of numeration for processing.

We will briefly discuss some of the path-breaking inventions in the field of computing devices.

(a) Calculating Machines

It took over generations for early man to build mechanical devices for counting large numbers. The first calculating device called ABACUS was developed by the Egyptian and Chinese people.

The word ABACUS means calculating board. It consisted of sticks in horizontal positions on which were inserted sets of pebbles. A modern form of ABACUS is given in Fig. 1.2. It has a number of horizontal bars each having ten beads. Horizontal bars represent units, tens, hundreds, etc.

![Fig. 1.2: Abacus Computer](image)

(b) Napier’s bones

English mathematician John Napier built a mechanical device for the purpose of multiplication in 1617 A.D. The device was known as Napier’s bones.
(c) Slide Rule

English mathematician Edmund Gunter developed the slide rule. This machine could perform operations like addition, subtraction, multiplication, and division. It was widely used in Europe in the 16th century.

(d) Pascal's Adding and Subtractive Machine

You might have heard the name of Blaise Pascal. He developed a machine at the age of 19 that could add and subtract. The machine consisted of wheels, gears and cylinders.

(e) Leibniz's Multiplication and Dividing Machine

The German philosopher and mathematician Gottfried Leibniz built around 1673 a mechanical device that could both multiply and divide.

(f) Babbage's Analytical Engine

It was in the year 1823 that a famous English man Charles Babbage built a mechanical machine to do complex mathematical calculations. It was called difference engine. Later he developed a general-purpose calculating machine called analytical engine. You should know that Charles Babbage is called the father of computer.

(g) Mechanical and Electrical Calculator

In the beginning of 19th century the mechanical calculator was developed to perform all sorts of mathematical calculations. Up to the 1960s it was widely used. Later the rotating part of mechanical calculator was replaced by electric motor. So it was called the electrical calculator.

Fig. 1.3: Switching Devices used in different generations of Computers
(h) Modern Electronic Calculator

The electronic calculator used in 1960 was run with electron tubes, which was quite bulky. Later it was replaced with transistors and as a result the size of calculators became too small.

The modern electronic calculator can compute all kinds of mathematical computations and mathematical functions. It can also be used to store some data permanently. Some calculators have in-built programs to perform some complicated calculations.

**INTEXT QUESTIONS 1.2**

1. What is the first mathematical device built and when was it built?
2. Who is called the father of Computer Technology.

**1.6 COMPUTER GENERATIONS**

You know that the evolution of computer started from 16th century and resulted in the form that we see today. The present day computer, however, has also undergone rapid change during the last fifty years. This period, during which the evolution of computer took place, can be divided into five distinct phases known as Generations of Computers. Each phase is distinguished from others on the basis of the type of switching circuits used.

**(a) First Generation Computers**

First generation computers used Thermion valves. These computers were large in size and writing programs on them was difficult. Some of the computers of this generation were:

**ENIAC:** It was the first electronic computer built in 1946 at University of Pennsylvania, USA by John Eckert and John Mauchy. It was named Electronic Numerical Integrator and Calculator (ENIAC). The ENIAC was 30(50) feet long, weighed 30 tons, contained 18,000 vacuum tubes; 70,000 registers, 10,000 capacitors and required 150,000 watts of electricity. Today your favorite computer is many times as powerful as ENIAC, still size is very small.

**EDVAC:** It stands for Electronic Discrete Variable Automatic Computer and was developed in 1950. The concept of storing data and instructions inside the computer was introduced here. This allowed much faster operation since the computer had rapid access to both data and instructions. The other advantages of storing instruction was that computer could do logical decision internally.

**Other Important Computers of First Generation**

**EDSAC:** It stands for Electronic Delay Storage Automatic Computer and was developed by M.V. Wilkes at Cambridge University in 1949.

**UNIVAC-1:** Ecker and Mauchly produced it in 1951 by Universal Accounting Computer setup.

**Limitations of First Generation Computer**

Followings are the major drawbacks of First generation computers.
1. The operating speed was quite slow.

2. Power consumption was very high.

3. It required large space for installation.

4. The programming capability was quite low.

(b) Second Generation Computers

Around 1955 a device called Transistor replaced the bulky electric tubes in the first generation computer. Transistors are smaller than electric tubes and have higher operating speed. They have no filament and require no heating. Manufacturing cost was also very low. Thus the size of the computer got reduced considerably.

It is in the second generation that the concept of Central Processing Unit (CPU), memory, programming language and input and output units were developed. The programming languages such as COBOL, FORTRAN were developed during this period. Some of the computers of the Second Generation were:

IBM 1620: Its size was smaller as compared to First Generation computers and mostly used for scientific purposes.

IBM 1401: Its size was small to medium and used for business applications.

CDC 3600: Its size was large and is used for scientific purposes.

(c) Third Generation Computers

The third generation computers were introduced in 1964. They used Integrated Circuits (ICs). These ICs are popularly known as Chips. A single IC has many transistors, registers and capacitors built on a single thin slice of silicon. So it is quite obvious that the size of the computer got further reduced. Some of the computers developed during this period were IBM-360, ICL-1900, IBM-370, and VAX-750. Higher level language such as BASIC (Beginners All purpose Symbolic Instruction Code) was developed during this period.

Computers of this generation were small in size, low cost, large memory and processing speed is very high.

(d) Fourth Generation Computers

The present day computers that you see today are the fourth generation computers that started around 1975. It uses large scale Integrated Circuits (LSIC) built on a single silicon chip called microprocessors. Due to the development of microprocessor it is possible to place computer's Central Processing Unit (CPU) on single chip. These computers are called microcomputers. Later very large scale Integrated Circuits (VLSIC) replaced LSICs.

Thus the computer which was occupying a very large room in earlier days can now be placed on a table. The personal computer (PC) that you see in your school is a Fourth Generation Computer.

(e) Fifth Generation Computer

The computers of 1990s are said to be Fifth Generation computers. The speed is extremely high in fifth generation computer. Apart from this it can perform parallel
processing. The concept of Artificial intelligence has been introduced to allow the computer to take its own decision. It is still in a developmental stage.

1.7 TYPES OF COMPUTERS

Now let us discuss the varieties of computers that we see today. Although they belong to the fifth generation they can be divided into different categories depending upon the size, efficiency, memory and number of users. Broadly they can be divided into the following categories.

1. Microcomputer: Microcomputer is at the lowest end of the computer range in terms of speed and storage capacity. Its CPU is a microprocessor. The first microcomputers were built of 8-bit microprocessor chips. The most common application of personal computers (PC) is in this category. The PC supports a number of input and output devices. An improvement of 8-bit chips is 16-bit and 32-bit chips. Examples of microcomputer are IBM PC, PC-AT.

2. Mini Computer: This is designed to support more than one user at a time. It possesses large storage capacity and operates at a higher speed. The mini computer is used in multi-user system in which various users can work at the same time. This type of computer is generally used for processing large volume of data in an organisation. They are also used as servers in Local Area Networks (LAN).

3. Mainframes: These types of computers are generally 32-bit microprocessors. They operate at very high speed, have very large storage capacity and can handle the work load of many users. They are generally used in centralised databases. They are also used as controlling nodes in Wide Area Networks (WAN). Examples of mainframes are DEC, ICL and IBM 3000 series.

4. Supercomputer: They are the fastest and most expensive machines. They have high processing speed compared to other computers. They have also multiprocessors technique. One of the ways in which supercomputers are built is by interconnecting hundreds of microprocessors. Supercomputers are mainly being used for weather forecasting, biomedical research, remote sensing, aircraft design and other areas of science and technology. Examples of supercomputers are CRAY YMP, CRAY2, NEC SX-3, CRAY XMP and PARAM from India.

INTEXT QUESTIONS 1.3

1. Into how many generations the evolution of computer is divided?
2. What is VLSIC?
3. The personal computer that you see today is in which generation of computer?

1.8 WHAT YOU HAVE LEARNT

In this lesson we have discussed about the major characteristics of computer. The speed, accuracy, memory and versatility are some of the features associated with the computer. But the computer that we see today has not developed over night. It has taken centuries of human effort to see the computer in its present form today. There are five generations of computer. Over these generations the physical size of computer...
has decreased, but on the other hand the processing speed of computer has improved
tremendously. We also discussed about the varieties of computers available today.

1.9 TERMINAL QUESTIONS
1. Why is computer known as data processor?
2. Explain in brief the various generations in computer technology?
3. Write a short note on Fifth Generation of computer. What makes it different from
   Fourth generation computer?
4. Why did the size of computer get reduced in third generation computer?

1.10 FEEDBACK TO IN-TEXT QUESTIONS

INTEXT QUESTION 1.1
1. A computer is an electronic device, which is used to accept, store, retrieve and
   process the data. It is called as data processor because it is mainly used for
   processing data for producing meaningful information.
2. The characteristics of computer are speed, accuracy, diligence, versatility and
   storage.

INTEXT QUESTIONS 1.2
1. Analytical engine, 1823.
2. Charles Babbage

INTEXT QUESTIONS 1.3
1. Five generations
2. Very Large Scale Integrated Circuits
3. Fourth Generation
2

COMPUTER ORGANISATION

2.1 INTRODUCTION
In the previous lesson we discussed about the evolution of computer. In this lesson we will provide you with an overview of the basic design of a computer. You will know how different parts of a computer are organised and how various operations are performed between different parts to do a specific task. As you know from the previous lesson the internal architecture of computer may differ from system to system, but the basic organisation remains the same for all computer systems.

2.2 OBJECTIVES
At the end of the lesson you will be able to:
- understand basic organisation of computer system
- understand the meaning of Arithmetic Logical Unit, Control Unit and Central Processing Unit
- differentiate between bit, byte and a word
- define computer memory
- differentiate between primary memory and secondary memory
- differentiate between primary storage and secondary storage units
- differentiate between input devices and output devices

2.3 BASIC COMPUTER OPERATIONS
A computer as shown in Fig. 2.1 performs basically five major operations or functions irrespective of their size and make. These are 1) it accepts data or instructions by way of input, 2) it stores data, 3) it can process data as required by the user, 4) it gives results in the form of output, and 5) it controls all operations inside a computer. We discuss below each of these operations.

1. Input: This is the process of entering data and programs into the computer system. You should know that computer is an electronic machine like any other machine which
takes as inputs raw data and performs some processing giving out processed data. Therefore, the input unit takes data from us to the computer in an organized manner for processing.

![Diagram of computer operations]

**Fig. 2.1 Basic Computer Operations**

2. **Storage**: The process of saving data and instructions permanently is known as storage. Data has to be fed into the system before the actual processing starts. It is because the processing speed of Central Processing Unit (CPU) is so fast that the data has to be provided to CPU with the same speed. Therefore, the data is first stored in the storage unit for faster access and processing. This storage unit or the primary storage of the computer system is designed to do the above functionality. It provides space for storing data and instructions.

The storage unit performs the following major functions:
- All data and instructions are stored here before and after processing.
- Intermediate results of processing are also stored here.

3. **Processing**: The task of performing operations like arithmetic and logical operations is called processing. The Central Processing Unit (CPU) takes data and instructions from the storage unit and makes all sorts of calculations based on the instructions given and the type of data provided. It is then sent back to the storage unit.

4. **Output**: This is the process of producing results from the data for getting useful information. Similarly, the output produced by the computer after processing must also be kept somewhere inside the computer before being given to you in human readable form. Again, the output is also stored inside the computer for further processing.
5. Control: The manner how instructions are executed and the above operations are performed. Controlling of all operations like input, processing and output are performed by control unit. It takes care of step by step processing of all operations inside the computer.

2.4 FUNCTIONAL UNITS

In order to carry out the operations mentioned in the previous section the computer allocates the task between its various functional units. The computer system is divided into three separate units for its operation. They are: 1) arithmetic logical unit, 2) control unit, and 3) central processing unit.

(a) Arithmetic Logical Unit (ALU)

After you enter data through the input device it is stored in the primary storage unit. The actual processing of the data and instruction are performed by Arithmetic Logical Unit. The major operations performed by the ALU are addition, subtraction, multiplication, division, logic and comparison. Data is transferred to ALU from storage unit when required. After processing the output is returned back to storage unit for further processing or getting stored.

(b) Control Unit (CU)

The next component of computer is the Control Unit, which acts like the supervisor seeing that things are done in proper fashion. The control unit determines the sequence in which computer programs and instructions are executed. Things like processing or programs stored in the main memory, interpretation of the instructions and issuing of signals for other units of the computer to execute them. It also acts as a switch board operator when several users access the computer simultaneously. Thereby it coordinates the activities of computer's peripheral equipment as they perform the input and output. Therefore it is the manager of all operations mentioned in the previous section.

![Computer Architecture](image)
(c) Central Processing Unit (CPU)

The ALU and the CU of a computer system are jointly known as the Central Processing Unit. You may call CPU as the brain of any computer system. It is just like brain that takes all major decisions, makes all sorts of calculations and directs different parts of the computer functions by activating and controlling the operations.

(d) Personal Computer Configuration

Now let us identify the physical components that make the computer work. These are

1. Central Processing Unit (CPU)
2. Computer Memory (RAM and ROM)
3. Data bus
4. Ports
5. Motherboard
6. Hard disk
7. Output Devices
8. Input Devices

All these components are inter-connected for the personal computer to work.

INTEXT QUESTIONS 2.1

1. What are the five basic operations performed by the computer?
2. Define ALU, CU and CPU.
3. Choose the correct answer:
   (a) The task of performing arithmetic and logical operations is called
      (i) ALU  (ii) editing  (iii) storage  (iv) output
   (b) The ALU and CU jointly known as
      (i) RAM  (ii) ROM  (iii) CPU  (iv) none of the above
   (c) The process of producing results from the data for getting useful information
      (i) output  (ii) input  (iii) processing  (iv) storage

2.5 MEMORY SYSTEM IN A COMPUTER

There are two kinds of computer memory: primary and secondary. Primary memory is accessible directly by the processing unit. RAM is an example of primary memory. As soon as the computer is switched off the contents of the primary memory is lost. You can store and retrieve data much faster with primary memory compared to secondary memory. Secondary memory such as floppy disk, magnetic disk, etc., is located outside the computer. Primary memory is more expensive than secondary memory. Because of this the size of primary memory is less than that of secondary memory. We will discuss about secondary memory later on.
Computer memory is used to store two things: i) instructions to execute a program and ii) data. When the computer is doing any job, the data that have to be processed are stored in the primary memory. This data may come from an input device like keyboard or from a secondary storage device like a floppy disk.

As program or the set of instructions is kept in primary memory, the computer is able to follow instantly the set of instructions. For example, when you book ticket from railway reservation counter, the computer has to follow the same steps: take the request, check the availability of seats, calculate fare, wait for money to be paid, store the reservation and get the ticket printed out. The programme containing these steps is kept in memory of the computer and is followed for each request.

But inside the computer, the steps followed are quite different from what we see on the monitor or screen. In computer’s memory both programs and data are stored in the binary form. You have already been introduced with decimal number system, that is the numbers 1 to 9 and 0. The binary system has only two values 0 and 1. These are called bits. As human beings we all understand decimal system but the computer can only understand binary system. It is because a large number of integrated circuits inside the computer can be considered as switches, which can be made ON, or OFF. If a switch is ON it is considered 1 and if it is OFF it is 0. A number of switches in different states will give you a message like this: 110101...10. So the computer takes input in the form of 0 and 1 and gives output in the form of 0 and 1 only. Is it not absurd if the computer gives outputs as 0’s & 1’s only? But you do not have to worry about. Every number in binary system can be converted to decimal system and vice versa, for example, 1010 meaning decimal 10. Therefore it is the computer that takes information or data in decimal form from you, convert it in to binary form, process it producing output in binary form and again convert the output to decimal form.

The primary memory as you know in the computer is in the form of IC’s (Integrated Circuits). These circuits are called Random Access Memory (RAM). Each of RAM’s locations stores one byte of information. (One byte is equal to 8 bits). A bit is an acronym for binary digit, which stands for one binary piece of information. This can be either 0 or 1. You will know more about RAM later. The Primary or internal storage section is made up of several small storage locations (ICs) called cells. Each of these cells can store a fixed number of bits called word length.

Each cell has a unique number assigned to it called the address of the cell and it is used to identify the cells. The address starts at 0 and goes up to (N-1). You should know that the memory is like a large cabinet containing as many drawers as there are addresses on memory. Each drawer contains a word and the address is written on outside of the drawer.

(a) Capacity of Primary Memory

You know that each cell of memory contains one character or 1 byte of data. So the capacity is defined in terms of byte or words. Thus 64 kilobyte (KB) memory is capable of storing $64 \times 1024 = 32,768$ bytes. (1 kilobyte is 1024 bytes). A memory size ranges from few kilobytes in small systems to several thousand kilobytes in large mainframe and super computer. In your personal computer you will find memory capacity in the range of 64 KB, 4 MB, 8 MB and even 16 MB (MB = Million bytes).
The following terms related to memory of a computer are discussed below:

(i) **Random Access Memory (RAM):** The primary storage is referred to as random access memory (RAM) because it is possible to randomly select and use any location of the memory directly store and retrieve data. It takes same time to any address of the memory as the first address. It is also called read/write memory. The storage of data and instructions inside the primary storage is temporary. It disappears from RAM as soon as the power to the computer is switched off. The memories, which loose their content on failure of power supply, are known as volatile memories. So now we can say that RAM is volatile memory.

(ii) **Read Only Memory (ROM):** There is another memory in computer, which is called Read Only Memory (ROM). Again it is the ICs inside the PC that form the ROM. The storage of program and data in the ROM is permanent. The ROM stores some standard processing programs supplied by the manufacturers to operate the personal computer. The ROM can only be read by the CPU but it cannot be changed. The basic input/output program is stored in the ROM that examines and initializes various equipment attached to the PC when the switch is made ON. The memories, which do not loose their content on failure of power supply, are known as non-volatile memories. ROM is non-volatile memory.

(iii) **PROM:** There is another type of primary memory in computer, which is called Programmable Read Only Memory (PROM). You know that it is not possible to modify or erase programs stored in ROM, but it is possible for you to store your program in PROM chip. Once the programmes are written it cannot be changed and remain intact even if power is switched off. Therefore programs or instructions written in PROM or ROM cannot be erased or changed.

(iv) **EPROM:** This stands for Erasable Programmable Read Only Memory, which over come the problem of PROM & ROM. EPROM chip can be programmed time and again by erasing the information stored earlier in it. Information stored in EPROM exposing the chip for some time ultraviolet light and it erases chip is reprogrammed using a special programming facility. When the EPROM is in use information can only be read.

(v) **Cache Memory:** The speed of CPU is extremely high compared to the access time of main memory. Therefore the performance of CPU decreases due to the slow speed of main memory. To decrease the mismatch in operating speed, a small memory chip is attached between CPU and Main memory whose access time is very close to the processing speed of CPU. It is called CACHE memory. CACHE memories are accessed much faster than conventional RAM. It is used to store programs or data currently being executed or temporary data frequently used by the CPU. So each memory makes main memory to be faster and larger than it really is. It is also very expensive to have bigger size of cache memory and its size is normally kept small.

(vi) **Registers:** The CPU processes data and instructions with high speed, there is also movement of data between various units of computer. It is necessary to transfer the processed data with high speed. So the computer uses a number of special memory units called registers. They are not part of the main memory but they store data or information temporarily and pass it on as directed by the control unit.
INTEXT QUESTIONS 2.2

1. Distinguish between bit and byte.
2. Define volatile and non-volatile memory.
3. Write True or False:
   (a) There are two kinds of computer memory primary and secondary.
   (b) The computer takes inputs in the form of 0 and 1.
   (c) The storage of program and data in the RAM is permanent.
   (d) PROM is secondary memory.
   (e) The memories which do not lose their content on failure of power supply are known as non-volatile memories.

2.6 SECONDARY STORAGE

You are now clear that the operating speed of primary memory or main memory should be as fast as possible to cope up with the CPU speed. These high-speed storage devices are very expensive and hence the cost per bit of storage is also very high. Again the storage capacity of the main memory is also very limited. Often it is necessary to store hundreds of millions of bytes of data for the CPU to process. Therefore additional memory is required in all the computer systems. This memory is called auxiliary memory or secondary storage.

In this type of memory the cost per bit of storage is low. However, the operating speed is slower than that of the primary storage. Huge volume of data are stored here on permanent basis and transferred to the primary storage as and when required. Most widely used secondary storage devices are magnetic tapes and magnetic disk.

(a) Magnetic Tape: Magnetic tapes are used for large computers like mainframe computers where large volume of data is stored for a longer time. In PC also you can use tapes in the form of cassettes. The cost of storing data in tapes is inexpensive. Tapes consist of magnetic materials that store data permanently. It
can be 12.5 mm to 25 mm wide plastic film-type and 500 meter to 1200 meter long which is coated with magnetic material. The deck is connected to the central processor and information is fed into or read from the tape through the processor. It is similar to cassette tape recorder.

**Advantages of Magnetic Tape:**

- **Compact:** A 10-inch diameter reel of tape is 2400 feet long and is able to hold 800, 1600 or 6250 characters in each inch of its length. The maximum capacity of such tape is 180 million characters. Thus data are stored much more compactly on tape.
- **Economical:** The cost of storing characters is very less as compared to other storage devices.
- **Fast:** Copying of data is easier and fast.
- **Long term Storage and Re-usability:** Magnetic tapes can be used for long term storage and a tape can be used repeatedly without loss of data.

(b) **Magnetic Disk:** You might have seen the gramophone record, which is circular like a disk and coated with magnetic material. Magnetic disks used in computer are made on the same principle. It rotates with very high speed inside the computer drive. Data is stored on both the surface of the disk. Magnetic disks are most popular for direct access storage device. Each disk consists of a number of invisible concentric circles called tracks. Information is recorded on tracks of a disk surface in the form of tiny magnetic spots. The presence of a magnetic spot represents one bit and its absence represents zero bit. The information stored in a disk can be read many times without affecting the stored data. So the reading operation is non-destructive. But if you want to write a new data, then the existing data is erased from the disk and new data is recorded.

![Diagram of Magnetic Disk](image)

**Floppy Disk:** It is similar to magnetic disk discussed above. They are 5.25 inch or .5 inch in diameter. They come in single or double density and recorded on one or both surface of the diskette. The capacity of a 5.25-inch floppy is 1.2 mega bytes
whereas for 3.5 inch floppy it is 1.44 mega bytes. It is cheaper than any other storage devices and is portable. The floppy is a low cost device particularly suitable for personal computer system.

(d) Optical Disk

With every new application and software there is greater demand for memory capacity. It is the necessity to store large volume of data that has led to the development of optical disk storage medium. Optical disks can be divided into the following categories:

- **Compact Disk/Read Only Memory (CD-ROM):** CD-ROM disks are made of reflective metals. CD-ROM is written during the process of manufacturing by high power laser beam. Here the storage density is very high, storage cost is very low and access time is relatively fast. Each disk is approximately 4½ inches in diameter and can hold over 600 MB of data. As the CD-ROM can be read only we cannot write or make changes into the data contained in it.

- **Write Once, Read Many (WORM):** The inconvenience that we can not write anything into a CD-ROM is avoided in WORM. A WORM allows the user to write data permanently on to the disk. Once the data is written it can never be erased without physically damaging the disk. Here data can be recorded from keyboard, video scanner, OCR equipment and other devices. The advantage of WORM is that it can store vast amount of data amounting to gigabytes (109 bytes). Any document in a WORM can be accessed very fast, say less than 30 seconds.

- **Erasable Optical Disk:** These are optical disks where data can be written, erased and re-written. This also applies a laser beam to write and re-write the data. These disks may be used as alternatives to traditional disks. Erasable optical disks are based on a technology known as magnetic optical (MO). To write a data bit on to the erasable optical disk the MO drive’s laser beam heats a tiny, precisely defined point on the disk’s surface and magnetises it.

### 2.7 INPUT OUTPUT DEVICES

A computer is only useful when it is able to communicate with the external environment. When you work with a computer, you feed your data and instructions through some devices to the computer. These devices are called Input devices. Similarly, computer after processing, gives output through other devices called output devices.
For a particular application one form of device is more desirable compared to others. We will discuss various types of I/O devices that are used for different types of applications. They are also known as peripheral devices because they surround the CPU and make a communication between computer and the outer world.

(a) Input Devices

Input devices are necessary to convert our information or data into a form which can be understood by the computer. A good input device should provide timely, accurate and useful data to the main memory of the computer for processing. Following are the most useful input devices.

(i) Keyboard: - This is the standard input device attached to all computers. The layout of keyboard is just like the traditional typewriter of the type QWERTY. It also contains some extra command keys and function keys. It contains a total of 101 to 104 keys. A typical keyboard used in a computer is shown in Fig. 2.6. You have to press correct combination of keys to input data. The computer can recognise the electrical signals corresponding to the correct key combination and processing is done accordingly.

![Keyboard Image](image)

Fig. 2.6 Keyboard

(ii) Mouse: Mouse is an input device shown in Fig. 2.7 that is used with your personal computer. It rolls on a small ball and has two or three buttons on the top.

![Mouse Image](image)

Fig. 2.7 Mouse
When you roll the mouse across a flat surface the screen cursor moves in the direction of mouse movement. The cursor moves very fast with mouse giving you more freedom to work in any direction. It is easier and faster to move through a mouse.

(iii) Scanner: The keyboard can input only text through keys provided in it. If we want to input a picture the keyboard cannot do that. Scanner is an optical device that can input any graphical matter and display it back. The common optical scanner devices are Magnetic Ink Character Recognition (MICR), Optical Mark Reader (OMR) and Optical Character Reader (OCR).

- **Magnetic Ink Character Recognition (MICR):** This is widely used by banks to process large volumes of cheques and drafts. Cheques are put inside the MICR. As they enter the reading unit the cheques pass through the magnetic field which causes the read head to recognise the character of the cheques.

- **Optical Mark Reader (OMR):** This technique is used when students have appeared in objective type tests and they had to mark their answer by darkening a square or circular space by pencil. These answer sheets are directly fed to a computer for grading where OMR is used.

- **Optical Character Recognition (OCR):** - This technique unites the direct reading of any printed character. Suppose you have a set of hand written characters on a piece of paper. You put it inside the scanner of the computer. This pattern is compared with a site of patterns stored inside the computer. Whichever pattern is matched is called a character read. Patterns that cannot be identified are rejected. OCRs are expensive though better the MICR.

(b) Output Devices

(i) Visual Display Unit: The most popular input/output device is the Visual Display Unit (VDU). It is also called the monitor. A Keyboard is used to input data and Monitor is used to display the input data and to receive messages from the computer. A monitor has its own box which is separated from the main computer system and is connected to the computer by cable. In some systems it is compact with the system unit. It can be colour or monochrome.

(ii) Terminals: It is a very popular interactive input/output unit. It can be divided into two types: hard copy terminals and soft copy terminals. A hard copy terminal provides a printout on paper whereas soft copy terminals provide visual copy on monitor. A terminal when connected to a CPU sends instructions directly to the computer. Terminals are also classified as dumb terminals or intelligent terminals depending upon the work situation.

(iii) Printer: It is an important output device which can be used to get a printed copy of the processed text or result on paper. There are different types of printers that are designed for different types of applications. Depending on their speed and approach of printing, printers are classified as impact and non-impact printers. Impact printers use the familiar typewriter approach of hammering a typeface against the paper and inked ribbon. Dot-matrix printers are of this type. Non-impact printers do not hit or impact a ribbon to print. They use electro-static chemicals and ink-jet technologies. Laser printers and Ink-jet printers are of this type. This type of printers can produce colour printing and elaborate graphics.
INTEXT QUESTIONS 2.3

1. Distinguish between impact and non-impact printers.
2. Define soft copy and hard copy terminals.
3. Write True or False:
   (a) Secondary memory is called auxiliary memory.
   (b) The magnetic tapes and magnetic disk are primary memories.
   (c) A CD-ROM is read only memory.
   (d) Mouse is an output device.
   (e) Printer is an important output device.

2.8 WHAT YOU HAVE LEARNT

In this lesson we discussed five basic operations that a computer performs. These are input, storage, processing, output and control. A computer accepts data as input, stores it, processes it as the user requires and provides the output in a desired format. The storage unit of a computer is divided into two parts: primary storage and secondary storage. We have discussed the devices used for these two types of storage and their usefulness.
2.9 TERMINAL QUESTIONS

1. What are the five basic operations performed by any computer system?
2. Draw a block diagram to illustrate the basic organization of computer system and explain the function of various units.
3. What is input device? How does it differ from output device?
4. Differentiate between RAM and ROM. Also distinguish between PROM and EPROM.
5. What is cache memory? How is it different from primary memory?
6. Write short notes on (a) Control Unit (b) Random Access Memory (RAM)

2.10 FEEDBACK TO INTEXT QUESTIONS

INTEXT QUESTIONS 2.1

1. The five basic operations that a computer performs are input, storage, processing, output and control.
2. ALU: Arithmetic Logic Unit
   CU: Control Unit
   CPU: Central Processing Unit
3. (a) i (b) iii (c) i

INTEXT QUESTIONS 2.2

1. A bit is an acronym for binary digit, which stands for one binary piece of information. This can be either 0 or 1. A byte is equal to 8 bits.
2. The memories which are erased if there is a power failure are known as volatile memories. RAM is an example of volatile memory. The memories, which do not lose their content on failure of power supply, are known as non-volatile memories. ROM is non-volatile memory.
3. (a) True (b) True (c) False (d) False (e) True

INTEXT QUESTIONS 2.3

1. Impact printers use the familiar typewriter approach of hammering a typeface against the paper and inked ribbon. Non-impact printers do not hit or impact a ribbon to print. They use electro-static chemicals and ink-jet technologies.
2. A hard copy terminal provides a printout on paper whereas soft copy terminals provide visual copy on monitor.
3. (a) True (b) False (c) True (d) False (e) True
3

AN INTRODUCTION TO WINDOWS 95

3.1 INTRODUCTION

Windows 95 is the upgraded version of Windows 3.x series with lots of new features embedded into it. It is a complete paradigm shift from windows 3.x working environment. It is the entry point to a 32-bit operating/computing environment with less set of hardware requirements. It has more compatibility with other software as compared to its previous version and provides easy installation. It also runs most of the Windows 3.x and Ms-DOS programs. Windows 95 also provides flexibility to configure hardware, easy link to a network or setup a network, install and uninstall programs automatically. It also has lots of other useful features like easy Internet access, multitasking, and its most useful feature is long file names.

3.2 OBJECTIVES

At the end of this lesson you would be able to

- understand the difference between Windows 3.11 and Windows95.
- able to work on Windows95
- appreciate the uses of Long file name
- appreciate the new look and feel of Windows95.

3.3 IMPROVED FEATURES OF WINDOWS 95

Graphical User Interface

As compared to Windows 3.x, Windows 95 provides user-friendlier interface to work on. Its improved graphical user interface makes learning and using Windows 95 more natural and easier for all types of users. It is more powerful, customizable and efficient. 95 made life much simpler while there is a need to access multiple programs. It is the gateway of accessing most of the functionality available in the computer loaded with Windows 95. Just Click on the Start button anytime to start any programs, open or find documents, change windows settings, get Help, manage Files, maintain system, and much more.
As the name suggests, the Task bar provides information and access to the entire task that has been currently activated by Windows 95. Using this one can keep track of what all programs have been activated and switched between them.

**Windows Explorer**

Windows Explorer is more or less acts as a File Manager for Windows 95, but with lots of new features. It is more efficient, faster and user friendly as compared to File Manager of Windows 3.x.

Using Explorer one can easily browse through all the drives and network resources available and manage files.

**Right Mouse Button**

Clicking on the right mouse button activates a pop-up menu in any program so as to help in completing a task efficiently.

**Long File Names**

As the Ms-DOS convention follows, non of the file used in DOS environment should be more than 8 characters of primary name and optional secondary name (extension) of three characters. However Windows 95 has broken this barrier. Windows 95 supports long file names, maximum of 255 characters. It also allowed space to be used in between file name. This helps to make files and folders (directory/subdirectory) easier to organize and find.

**Shortcuts**

As the name suggests, SHORTCUTS are the shortest way to access programs, files and other resources in Windows 95. Instead of going through the structural process of accessing a program, one can create “shortcuts” to access them. It creates links for easy access to files, programs, folders, and more.

**Multitasking**

Multitasking allows the user to activate and accomplish more than one task at a time. For example, work on a document file in WORD programs, while copying file from other computer available in the network. With Windows 95, 32-bit computing environment, the user can do more than one task a time.

**Easy Internet Access**

One of the most useful and entirely new features is Windows 95 easy access to Internet. It provides built-in Internet functionality to setup link and access Internet with less amount of Hardware and Software requirement. It also provides connectivity software from Microsoft Network (MSN), CompuServe, and America Online. It also improves the efficiency of working on Internet with applications that support the latest Internet technologies such as ActiveX, Java, and streaming audio and video.

**Software Compatibility**

Windows 95 provides complete backward compatibility. It is easily compatible with applications developed for MS-DOS and Windows 3.x environment. It also supports the latest 32-bit technology. Most of the latest software packages are now built on Windows 95 operating environment.
Great Gaming Platform

Windows 95 support rich graphics, high quality audio and video. It also requires all most no editing of Config.sys files so as to support these technologies. All this is possible because of Windows 95 compatibility with latest and hottest technologies like Plug and Play, AutoPlay, and built-in support for MIDI and digital and surrounds video.

Hardware Compatibility

Windows 95 provides greater Hardware compatibility as compare to any other operating environment. It has flexibility of supporting hardware from different vendors. Its Plug and Play functionality allows to insert the hardware card into the computer and when the computer is turned on Windows 95 automatically recognizes and sets up the hardware.

Find Utility

Find Utility of Windows 95 allows you to do searches by partial name, last modified date, or full text. In addition, you can save, rename, or view files from within the result pane, just like you can from Windows Explorer.

Help

Windows 95 provides online help to accomplish a task. If the user is not sure how to perform a task, Windows 95 Help will provide structured process how to accomplish the task. Simply right-click on any object in the user interface (icons) and you'll get relevant descriptions about that object.

(a) System Requirements

<table>
<thead>
<tr>
<th>CPU</th>
<th>Recommended 486/25 MHz-based system or more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Recommended a minimum of 8-MB memory (RAM).</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>Available free hard disk space of 40-50 MB.</td>
</tr>
<tr>
<td>Display</td>
<td>VGA or higher-resolution display</td>
</tr>
<tr>
<td>Operating System</td>
<td>MS-DOS</td>
</tr>
<tr>
<td>Peripheral/Miscellaneous</td>
<td>Compatible pointing device</td>
</tr>
</tbody>
</table>

(b) Windows Desktop Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Computer</td>
<td>Provides direct access to local drives, printers, Control panel, and the Dial-up Network utility.</td>
</tr>
<tr>
<td>Network Neighborhood</td>
<td>Access to shared resources on the machine and computers on local and wide area network.</td>
</tr>
<tr>
<td>Recycle Bin</td>
<td>Provides drag and drop facilities, deletion of file from folders in the machine and provides a second chance to recover files deleted from the hard disk.</td>
</tr>
</tbody>
</table>
3.4 START BUTTON AND TASK BAR

Windows features the Start button and Taskbar at the bottom of the screen. This bar contains the Start button. Using this button, a program can be quickly started or file can be searched for. Quick help on how to use windows can also be obtained from this task bar.
Click on the Start to activate the Pop-up menu so as to open a program, find a file or folders (directory or sub-directory), and change the settings for Windows95, Run a program or shut down the computer and also to get help on windows 95.

If you have opened more than one program or windows, you can switch between them. All the opened windows or program appears on the Start or the Task bar as a minimized icons. Click on the desired icon to open the designated program. Similarly if you don’t need a windows too frequently, click on the minimized button of the windows. This will send the activated window as small icon to the task bar.

(a) Steps to start a program

1. Click on the Start button, and then point to Programs option.
2. Select the program you want to run. If the program you want is not on the menu, point to the folder that contains the program.
3. Click on the program icon or menu.

Once the selected program starts, a small icon appears on the taskbar. If you have opened more than one program, click on the required program icon on the taskbar to make it currently activated program.

If the desired program is not available on the program menu or one of its submenus, point to Find on the Start menu, and then click Files Or Folders where the program resides. You can also use the Find dialog box to locate the program file.

(b) Steps to open a recently used document

1. Click on the Start button
2. Select/point to Documents option.
3. Select the document you want to open, by clicking on it.

Note:

All programs are not capable of adding files to Document menu. So if the desired document to be opened is not listed or available in Document Menu, click on the Start button, and then select the Find option. Select/Click “Files Or Folders” option, and then use the Find dialog box to locate the file.

3.5 MY COMPUTER

It allows looking at a glance to all the resource available on the machine such as floppy drive, CD-ROM drive, Hard Disk etc. If you have network drives mapped as local drives they will also show up here. Double clicking on a drive in the top level of my computer will open another window containing the main folders on the select drive. Double clicking on any of the folders in the drive window will open another window showing the contents of the folder.

Double clicking on either the Control Panel folder or the Printers folders in My Computer windows will activate the respective windows for Control panel or Printers. Using this you can manipulate the settings for your Computer or Printer the same way that you were accessing them from the Start menu.
My Computer is the quickest way of accessing all the resources available on the computer. Even this can be used to copy, move, delete files among or between floppy and Hard Disk or network drives.

My Computer also provides the tools to change the settings of the available resources. Select the media such as floppy disk, hard disk drive you want to change the settings and right click on it. This will activate a Pop-Up menu. Now select the Properties option from the pop-up menu. This action will display the property windows with three options: General, Tools and Sharing. Using these three options you can change the properties of the selected media.
3.6 WINDOWS EXPLORER

As the name suggests, Windows Explorer let you explore the contents of your computer and do file management. It is the improved version of File Manager in Windows 3.1 or 3.11.

![Windows Explorer](image)

**Fig. 3.5**

To activate Windows Explorer, Click on the Start Button on the Task Bar and select Programs option. This will activate another Pop-Up menu. Now select Windows Explorer Option.

Windows Explorer displays on the left-hand side of the screen, all the folders on your computer in a hierarchical order. On the right hand side of the screen, it displays all the files and folders in each selected folder.

![File Menu](image)

**Fig. 3.6**
Windows Explorer is especially useful for copying and moving files. You can open the folder that contains the file you want to move or copy, and then drag it to the folder you want to put it in.

**Steps to copy a file or folder**

1. Go to My Computer or Windows Explorer
2. Select the file you want to copy by clicking on it
3. Go to Edit Menu and Select/Click Copy option
4. Open the folder or disk drive where you want to copy.
5. Again go to Edit Menu and Select/Click Paste option.

**Steps to move a file or folder**

1. Go to My Computer or Windows Explorer
2. Select the file you want to move by clicking on it.
3. Go to Edit Menu and Select/Click Cut option
4. Open the folder or disk drive where you want to move.
5. Again go to Edit Menu and Select/Click Paste option.

**Steps to delete a file or folder**

1. Go to My Computer or Windows Explorer
2. Select the file or folder you want to delete by clicking on it.
3. Go to File Menu and Select/Click Delete option.

**Note:**

- Files or folder deleted are stored in the Recycle Bin until the Recycle Bin is emptied. Files or folders can also be deleted by dragging file or folder icons onto the Recycle Bin icon. If SHIFT key is pressed while dragging, the item will be deleted permanently from the computer without being stored in the Recycle Bin.
- To select more than one file or folder to copy, while pressing the CTRL key, click the items you want to select.

**Steps to copy a file to a floppy disk**

1. Insert the disk in the floppy disk drive.
2. Go to My Computer or Windows Explorer
3. Select the File you want to Copy, by clicking on the file.
4. Go to File menu, point to “Send To” option, and then select the drive you want to copy the file to.

**Steps to create a new folder**

1. Go to My Computer or Windows Explorer; open the folder in which you want to create a new folder by double clicking on it.
2. Go to the File menu, point to New, and then click on the “Folder” option.
3. The new folder appears with a temporary name.
4. Type a name for the new folder, and then press ENTER.

Steps to change the name of a file or folder
1. Go to My Computer or Windows Explorer
2. Click on the file or folder you want to rename.
3. Go to the File menu, and Select/Click “Rename” option.
4. Type a new name for the file or Folder, and then press ENTER.

Note:
As Windows 95 supports long file name, a filename can be up to 255 characters, including spaces. However, it cannot contain any of the following characters:
/ \ * ? " <> |

3.7 NETWORK NEIGHBORHOOD

A Network is a group of Computers connected to each other to share available resources such as storage and printers. Network neighborhood takes the ability of My Computer and extends them one step further, by giving you with the ability to view all of the Computers connected in workgroup or network, and see what drives or Printers may be available for use. If you double click on one of the Computers, any resources that Computer shares with others in the workgroup like- drives, directories or printers will be listed.

When connected to a network, the Network Neighborhood icon appears on the desktop. To browse through the computers in the workgroup and the computers on the entire network, double click on the icon Network Neighborhood.
3.8 RECYCLE BIN

The files deleted by you are put in the Recycle Bin, a holding place for files that are no longer needed. There you can also drag and drop files for quick deleting. They are, however, not actually removed from the hard disk until the user “empty” the Recycle Bin.

It is a safety feature, built in to protect you against the possibility of deleting something you should not have.
3.9 FIND

Using Windows 95 it is easy to locate files and folders on the computer. One way is to browse through folders in My Computer. But if you want to find something quickly, you can use the Find command on the Start menu.

Click on the Start button and select “Find” option. Now select the Option “Files or Folders”. This will activate the Find Dialog box. In the Find dialog box, type the name of the file or folder you are looking for, and then click Find Now. You can also use wildcard character to Find files.
3.10 WORK WITH PROGRAMS

Windows 95 provides higher level of flexibility in terms of installing and removing programs.

**To install a program from a floppy disk or CD-ROM**

1. Select Control Panel from the Settings option of Start Menu
2. Double Click on the Add/Remove Programs icon.
3. Follow the instructions on your screen

**To install a program from a network**

1. Click here to open the Add/Remove Programs dialog box.

2. If the Install/Uninstall tab is selected, and your computer is already connected to a network, click Install button, and then click Next. Follow the instructions on your screen.

**Note**

If you do not have a Network Install tab in the Add/Remove Programs dialog box, this feature has not been enabled on your computer, your network, or both. See your system administrator.

If you are not already connected to the shared folder you want to install from, you must connect to it by using My Computer or Windows Explorer, or type the path to it in the text box.

**To remove a program from your computer**

1. Select Control Panel from the Settings option of Start Menu
2. Double Click on the Add/Remove Programs icon.
3. Follow the instructions on your screen.

**Note**

Only programs that were designed for Windows 95 can be removed by using Add/Remove Programs. For all other programs, check the program's documentation to determine which files should be removed.

3.11 MS-DOS WINDOW

Windows 95 provides the flexibility of executing most of the DOS commands or DOS based program without going out of Windows 95 GUI. To use DOS prompt,

1. Click the Start button, and then point to Programs.
2. Click/Select MS-DOS Prompt.
**Tips**

- To view the toolbar, click the MS-DOS icon in the title bar, and then click Toolbar.
- To switch between a full screen and a window, press ALT+ENTER.
- To quit MS-DOS, click or type `Exit` at the command prompt.

### 3.12 SHUT DOWN THE COMPUTER

Click the Start button, Click the Shut Down button, and then select the option Shut down the Computer and click on the Yes button.
Important

Do not turn off your computer until the “You can now safely turn off your computer” message appears.

3.13 CHANGE WINDOWS SETTINGS

Windows 95 provides tools to change the look and feel of the desktop window. Using these tools you can change the desktop background, wallpaper and lots of other settings according to your choice.

To activate these tools, right click on the window. This will display a menu now select the Properties option.

You can also activate these tools from Control panel by selecting the Display icon.

![Windows Setting Menu]

Desktop Background

To change the background of the desktop

- Right Click on the Desktop to view the Display properties.
- In the Pattern or Wallpaper list, click the pattern or wallpaper you want to use.
Tips

- To cover the entire screen with wallpaper image, click *Tile*.
- To center a wallpaper image, click *Center*.
- Patterns and wallpaper can be used simultaneously. However, you will not be able to see the pattern, if *Tile* is selected.

Similarly all other option such as *Appearance*, *Screen Saver* and *Settings* can be used. Using the *Settings* option, one can select the number of colors, pixel type and display adapter for the system.

**INTEXT QUESTIONS 3.1**

1. Which of the following is introduced exclusively in Windows95?
   (a) Control panel
   (b) File manager
   (c) Start button
   (d) None of the above
2. What is the Windows 3.x series equivalent to Windows Explorer in Windows 95?
   (a) Program manager
   (b) File manager
   (c) Print manager
   (d) None of the above

3. Answer whether the following statement is True (T) or False (F).
   (a) Windows 95 supports file name of 255 characters including space in between.
   (b) Windows 95 does not support Ms-DOS based application.
   (c) Windows 95 is a application software.
   (d) In Windows 95 desktop icons can be created, but can not be deleted.

4. Fill in the blanks
   (a) Inbox in Windows 95 is used for ____________.
   (b) GUI stands for ____________.

3.14 WHAT YOU HAVE LEARNT

This lesson introduced you to one of the most popular and widely used GUI operating system in desktop environment. In the beginning it discussed what is GUI and its usefulness. It explained the new features of Windows 95 and hardware requirement for installation. You also learned about various Windows 95 icons and their usability. Here we discussed how to do file management in Windows 95, and also we learned how to change look and feel of Windows 95 desktop according to user requirement.

3.15 TERMINAL QUESTIONS

1. Briefly explain, how Windows 95 is different from Windows 3.x series.
2. Explain what do you understand by multitasking?
3. What is the minimum hardware requirement for installing Windows 95 software?
4. What is the purpose of recycle bin?
5. Explain the steps involved to shut down Windows 95.

3.16 FEEDBACK TO IN-TEXT QUESTIONS

INTEXT QUESTIONS 3.1

1. (c) 
2. (b) 
3. (a) True (b) False (c) False (d) False
4. (a) Getting e-mail, (b) Graphical User Interface.
INTRODUCTION TO MS-WORD

4.1 INTRODUCTION

Let us consider an office scene. Many letters are typed in the office. The officer dictates a letter. The typist first types a draft copy of the letter. The officer goes through it to check mistakes regarding spelling errors, missing words, etc. and suggests corrections. The typist changes the letter as suggested by the officer. This is a simple example of word processing.

There are many software packages to do the job of word processing. Some of them work in DOS environment. Examples are WordStar, Word Perfect and Professional Write. But in these days working in WINDOWS is becoming more and more popular. So let us consider software for word processing which works in WINDOWS. Our choice is MS-WORD because it is the most popular software in these days.

MS-WORD is a part of the bigger package called MS OFFICE, which can do much more than word processing. In fact when you open up MS OFFICE you will find four main components in it. They are MS-WORD (for word processing), MS EXCEL (for spreadsheet), MS ACCESS (for database management) and MS POWERPOINT (for presentation purposes). However, we will limit ourselves to MS-WORD only in this lesson.

4.2 OBJECTIVES

After going through this lesson you should be in a position to:

- start the MS-WORD package
- be familiar with the MS-WORD screen
- advantages and Features of Word Processing
- some common Word Processing Packages
  - how to invoke Ms-Word
- learn the capabilities of Ms-Word
4.3 WHAT IS WORD-PROCESSING?

Word Processor is a Software package that enables you to create, edit, print and save documents for future retrieval and reference. Creating a document involves typing by using a keyboard and saving it. Editing a document involves correcting the spelling mistakes, if any, deleting or moving words sentences or paragraphs.

(a) Advantages of Word Processing

One of the main advantages of a word processor over a conventional typewriter is that a word processor enables you to make changes to a document without retyping the entire document.

(b) Features of Word Processing

Most Word Processor available today allows more than just creating and editing documents. They have wide range of other tools and functions, which are used in formatting the documents. The following are the main features of a Word Processor.

i) Text is typing into the computer, which allows alterations to be made easily.

ii) Words and sentences can be inserted, amended or deleted.

iii) Paragraphs or text can be copied/moved throughout the document.

iv) Margins and page length can be adjusted as desired.

v) Spelling can be checked and modified through the spell check facility.

vi) Multiple document/files can be merged.

vii) Multiple copies of letters can be generated with different addresses through the mail-merge facility.

(c) Some Common Word Processing Packages

The followings are examples of some popular word processor available.

- Softword
- WordStar
- Word perfect
- Microsoft word

4.4 IMPORTANT FEATURES OF MS-WORD

Ms-Word not only supports word processing features but also DTP features. Some of the important features of Ms-Word are listed below:

i) Using word you can create the document and edit them later, as and when required, by adding more text, modifying the existing text, deleting/moving some part of it.

ii) Changing the size of the margins can reformat complete document or part of text.

iii) Font size and type of fonts can also be changed. Page numbers and Header and Footer can be included.

iv) Spelling can be checked and correction can be made automatically in the entire document. Word count and other statistics can be generated.
v) Text can be formatted in columnar style as we see in the newspaper. Text boxes can be made.
vi) Tables can be made and included in the text.

vii) Word also allows the user to mix the graphical pictures with the text. Graphical pictures can either be created in word itself or can be imported from outside like from Clip Art Gallery.
viii) Word also provides the mail-merge facility.

ix) Word also has the facility of macros. Macros can be either attached to some function/special keys or to a tool bar or to a menu.

x) It also provides online help of any option.

INTEXT-QUESTION 4.1

State True or False

1. (a) Word processor is Software Package that enables you to create, edit, print and save document.

   (b) WordStar is a popular Word processor.

   (c) Changing the size of the margins cannot reformat complete document or part of the text.

   (d) Word has the facility of Macros.

   (e) Word does not allow the user to mix the graphical pictures with text.

4.5 GETTING STARTED WITH MS-WORD

We have already told you that for working in Ms-Word you should be familiar with WINDOWS. If you have not covered WINDOWS so far then read that first and then go through MS-WORD. By now you must be aware of the fact that a software package is improved from time to time. These improvements are sold in the market as new versions of the same software. Thus you will find many versions of MS-WORD being used in different offices. In this lesson we will cover the version MS-WORD 97, which is latest in the market and contain many improvements over the older versions. However, you do not have to worry if you have an older version such as WORD 6.0 or WORD 95. All the commands available in these older versions are also available in WORD 97 and they are compatible.

While working in MS-WORD you have to work with a mouse. Also one can work, to some extent, through the keyboard. The use of mouse is simpler as it is fully menu driven. In MS-WORD every command is available in the form of ‘icons’.

You can go inside MS-WORD by the following way

1. Take the mouse pointer to START button on the task bar. Click the left mouse button. The monitor will show like as follows:
2) Move the pointer to programs. You will notice another menu coming up to the right.

3) In that menu identify where Microsoft word is placed. Move the cursor horizontally to come out of programs.

4) Move in to the rectangular area meant for Microsoft word. Click the left mouse button there. The computer will start MS-WORD. You will find the screen as follows:
Let us discuss the important components of the screen.

(i) Title Bar
The title bar displays the name of the currently active word document. Like other WINDOWS applications, it can be used to alter the size and location of the word window.

(ii) Tool Bars
Word has a number of tool bars that help you perform task faster and with great ease. Two of the most commonly tool bars are the formatting tool bar and the standard tool bar. These two toolbars are displayed just below the title bar. At any point of time any tool bar can be made ON or OFF through the tool bar option of View Menu.

(iii) Ruler Bar
The Ruler Bar allows you to format the vertical alignment of text in a document.

(iv) Status Bar
The Status Bar displays information about the currently active document. This includes the page number that you are working, the column and line number of the cursor position and so on.
(v) Scroll Bar

The Scroll Bar helps you scroll the content or body of document. You can do so by moving the elevator button along the scroll bar, or by click in on the buttons with the arrow marked on them to move up and down and left and right of a page.

(vi) Workspace

The Workspace is the area in the document window where you enter/type the text of your document.

(vii) Main Menu

The Word main menu is displayed at the top of the screen as shown in the Fig. 4.1. The main menu further displays a sub menu. Some of the options are highlighted options and some of them appear as faded options. At any time, only highlighted options can be executed, faded options are not applicable. Inspect if the option is faded you will not be able to choose it. You may not that any option faded under present situation may become highlighted under different situations.

INTEXT QUESTIONS 4.2

1. Choose the best answer.

(a) While working in Ms-Word you have to work with
   (i) Mouse only
   (ii) Keyboard only
   (iii) Both mouse and keyboard

(b) In Ms-Word every command is available in
   (i) Print
   (ii) Letter
   (iii) Icons

(c) You can go inside Ms-Word by the following way
   (i) Take the mouse pointer to START button on the task bar and click the left mouse button.
   (ii) Take the mouse pointer to START button and click the right mouse button.
   (iii) Move the mouse pointer on the screen.

2. State True or False

(a) The title bar displays the name of the currently active word document.

(b) Two of the most commonly tool bars are the formatting tool bar and the standard tool bar.

(c) The tool bar allows you to format the vertical alignment of text.

(d) The scroll bar helps you to scroll the content or body of document.

(e) The workspace is the area in the document window where you enter/type the text.
### 4.6 MAIN MENU OPTIONS

The overall functions of all the items of main menu are explained below.

**a) File**

You can perform file management operations by using these options such as opening, closing, saving, printing, exiting etc. It displays the following sub menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New...</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open...</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
</tr>
<tr>
<td>Save as HTML</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Send To</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td></td>
</tr>
<tr>
<td>1.NOS1.Doc</td>
<td></td>
</tr>
<tr>
<td>2.NOS2.Doc.</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 4.3 File Sub menu**

<table>
<thead>
<tr>
<th>Option</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Clear</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Repeat/Clear</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Paste Special</td>
<td></td>
</tr>
<tr>
<td>Clear</td>
<td>Delete</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Replace</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Go to</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Links</td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td></td>
</tr>
</tbody>
</table>

**Fig 4.4 Edit Sub menu**
(b) Edit

Using this option you can perform editing functions such as cut, copy, paste, find and replace etc. It displays the following submenu in Fig. 4.4.

(c) View

Word document can be of many pages. The different pages may have different modes. Each mode has its limitations. For example in normal mode the graphical picture cannot be displayed. They can only be displayed in page layout mode. Using the option "View" you can switch over from one mode to other. It displays the following Sub menu.

```
Normal
Online Layout
Page Layout
Outline
Master Document

Tool Bars
Ruler

Header and Footer
Footnotes
Comments
Full Screen
Zoom...
```

(d) Insert

Using this menu, you can insert various objects such as page numbers, footnotes, picture frames etc. in your document. It displays the following Sub menu.

```
Break...
Page Numbers...
Date and Time...
AutoText
Field...
Symbol...
Comment

Footnote...
Caption...
Cross-reference...
Index & Tables...
```
(e) Format

Using this menu, you can perform various types of formatting operations, such as fonts can be framed etc. It displays the following Sub menu.

<table>
<thead>
<tr>
<th>Font</th>
<th>Paragraph</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bullets and Numbering</td>
<td>Borders and Shading</td>
</tr>
<tr>
<td>Columns</td>
<td>Tabs</td>
</tr>
<tr>
<td>Drop Cap</td>
<td>Text Direction</td>
</tr>
<tr>
<td>Change Case</td>
<td>Auto Format</td>
</tr>
<tr>
<td>Style Gallery</td>
<td>Style</td>
</tr>
<tr>
<td>Background</td>
<td>Object</td>
</tr>
</tbody>
</table>

(f) Tools

Using this menu, you can have access to various utilities/tools of Word, such as spell check, macros, mail merge etc. It displays the following Sub menu.

<table>
<thead>
<tr>
<th>Spelling and Grammar</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Count</td>
<td>AutoSummarise</td>
</tr>
<tr>
<td>Auto Correct</td>
<td>Auto Correct</td>
</tr>
<tr>
<td>Look Up Reference</td>
<td>Track Change</td>
</tr>
<tr>
<td>Merge Documents</td>
<td>Protect Document</td>
</tr>
</tbody>
</table>
### Table

This menu deals with tables. Using this menu you can perform various types of operations on the table. It displays the following Sub menu.

<table>
<thead>
<tr>
<th>Draw Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Table...</td>
</tr>
<tr>
<td>Delete Cells...</td>
</tr>
<tr>
<td>Merge Cells...</td>
</tr>
<tr>
<td>Split Cells...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Select Row</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Column</td>
</tr>
<tr>
<td>Select Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table Auto Format...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribute Rows Evenly</td>
</tr>
<tr>
<td>Distribute Columns Evenly</td>
</tr>
<tr>
<td>Cell Height and Width...</td>
</tr>
<tr>
<td>Headings</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Convert Text to table...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort ...</td>
</tr>
<tr>
<td>Formula...</td>
</tr>
<tr>
<td>Split Table</td>
</tr>
<tr>
<td>Hide Grid Lines</td>
</tr>
</tbody>
</table>

### Window

This menu allows you to work with two documents simultaneously. This would require two windows to be opened so that each one can hold one document. Using this menu, you can switch over from one window to another. It displays the following Sub menu.
NEW WINDOW
ARRANGE ALL
SPLIT
1Document1.doc

Fig. 4.10 Window Sub menu

(i) Help

Using this menu, you can get on-line help for any function.

INTEXT QUESTION 4.3

1. State True or False

   (a) Using View option you can perform editing functions such as cut, copy, paste, find and replace etc.

   (b) Using the Edit option you can switch over from Normal mode to Outline mode.

   (c) Using Insert menu you can insert various objects such as page numbers, footnotes, picture frames etc.

   (d) Using Tools menu you can access to various utilities of word such as spell check, macros and mail merge etc.

   (e) Window menu allows you to work with two documents simultaneously.

4.7 WHAT YOU HAVE LEARNT

At the end of this lesson you have learnt the important features of Ms-Word. We started with procedure to invoke Ms-Word. We identified toolbars available in the main menu of Ms-Word are discussed.

4.8 TERMINAL QUESTIONS

1. What do you understand by Word processing? Give examples

2. Describe the important features of Ms-Word:

3. Describe the various options available in the main menu bar of Ms-Word.

4.9 FEEDBACK TO IN-TEXT QUESTIONS

INTEXT QUESTIONS 4.1

1. (a) True  (b) True  (c) False  (d) True  (e) False

INTEXT QUESTIONS 4.2

1. (a) iii  (b) iii  (c) i

2. (a) True  (b) True  (c) False  (d) True  (e) True

INTEXT QUESTIONS 4.3

1. (a) False  (b) False  (c) True  (d) True  (e) True
5

CREATING AND EDITING A DOCUMENT

5.1 INTRODUCTION

Now you are familiar with the basics of Ms-Word. After invoking Ms-Word, the next step is to create a file or document in which you can work. By default Ms-Word opens a new blank document when you start it. As you have seen from fig. 4.2 in the previous lesson, you noticed a blank work area where you can straight away type your text.

However, let us close this work area by clicking the left mouse button at file on the main menu bar and then at close. The work area will disappear. Now, suppose you want to create a new document.

5.2 OBJECTIVES

At the end of the lesson you would be able to do the following functions:

- creating a file
- opening an existing file
- insert text in a file
- editing the document
- deletion of text
- copying
- moving
- undo/repeat the last command
- replacing text
- save and exit
5.3 CREATING A DOCUMENT

You can create a document by clicking on file from the menu bar and then selecting New. Ms-Word will prompt you to choose a document or a template as shown in Fig. 5.1. In Ms-Word there is a keyboard equivalence of each command. In each option of the main menu you notice that an alphabet of that option is underlined (F in file, E in edit, V in view, etc.). If you type that alphabet while pressing the ALT key that particular option is invoked. For example, you can type in Alt+F to open the file option from the main menu.

![Screenshot of Microsoft Word interface](image)

**Fig. 5.1 Selecting a New Document**

Choose the default Document and General and then click on OK. A blank document will be displayed where in you can type the text. Ms-Word gives a temporary name to this file as ‘Document 1’, until you save that document with a file name.

Instead of clicking File and New you can directly open a new document by clicking at the NEW icon on the standard tool bar (the first icon on standard tool bar). Ms-Word provides the facility that as you take the mouse pointer to a particular icon a message will pop up. For example, as you take the mouse button to the first icon on the standard tool bar, you will suddenly find NEW written there.
5.4 ENTERING TEXT IN THE DOCUMENT

After you create a document, you can start typing the required text. The text will appear on the screen at the current location of the cursor. Ms-Word will automatically take care of the right margin of the text. The insertion point moves automatically to the next line. If you want to start a line or paragraph at the middle you have to press Enter key (↵).

5.5 MOVING AROUND THE DOCUMENT

Before you start edit, the cursor must be brought to the desired location. Following are a few of the keys that can be used to move around in a document:

<table>
<thead>
<tr>
<th>Press</th>
<th>Name of key(s)</th>
<th>To move cursor to</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Left arrow</td>
<td>Left by one character</td>
</tr>
<tr>
<td>→</td>
<td>Right arrow</td>
<td>Right by one character</td>
</tr>
<tr>
<td>↑</td>
<td>Up arrow</td>
<td>Up by one line</td>
</tr>
<tr>
<td>↓</td>
<td>Down arrow</td>
<td>Down by one line</td>
</tr>
<tr>
<td>Ctrl + ←</td>
<td>Ctrl and left arrow</td>
<td>Previous word</td>
</tr>
<tr>
<td>Ctrl + →</td>
<td>Ctrl and right arrow</td>
<td>Next word</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Ctrl and Home</td>
<td>Beginning of a line</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Ctrl and End</td>
<td>End of a line</td>
</tr>
<tr>
<td>Page Up</td>
<td>Page Up</td>
<td>Up by one page</td>
</tr>
<tr>
<td>Page Down</td>
<td>Page Down</td>
<td>Down by one page</td>
</tr>
</tbody>
</table>

5.6 EDITING OPERATIONS

When you enter your text, you are likely to make mistakes. Corrections of these mistakes are called editing. While editing, the need may arise to:

- Delete a part of the text.
- Move a block of text from one place to another.
- Copy a block of text from one place to other place.

Word provides facilities for all those editing activities but the work rule is to select the text first and then perform the action. Text can be selected using the mouse or the keyboard. The following table illustrates the methods, which basically follows click and drag rule.
<table>
<thead>
<tr>
<th>To select</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any variable length of Text</td>
<td>Drag the mouse over the text to be selected.</td>
</tr>
<tr>
<td>A word</td>
<td>Double click the mouse on the particular word.</td>
</tr>
<tr>
<td>A graphic</td>
<td>Click the graphic.</td>
</tr>
<tr>
<td>A line of text</td>
<td>Click in the selection bar to the left of the line.</td>
</tr>
<tr>
<td>Multiple lines of text</td>
<td>Drag in the selection bar to the left of the lines.</td>
</tr>
<tr>
<td>A sentence</td>
<td>Hold down CTRL and click anywhere in the sentence.</td>
</tr>
<tr>
<td>A paragraph</td>
<td>Double click in the selection bar next to the paragraph.</td>
</tr>
<tr>
<td>Multiple paragraph</td>
<td>Drag in the selection bar</td>
</tr>
</tbody>
</table>

5.7 INSERTING, REPLACING AND DELETING CHARACTER

Ms-Word usually inserts characters at the insertion point.

(i) Inserting Character

To insert characters, position the cursor at the required point and type them. Word automatically reformats the paragraph and moves words that do not fit on the current line to the next line or form the current page to the next page, as the case may be.

(ii) Replacing Character

Suppose you have typed some text. Now you want to replace it with some other. What you have to do is to highlight the text by dragging the mouse. Next type in the new material. Ms-Word will overwrite the existing material with the new material.

(iii) Deleting Characters

By pressing either the backspace or the Del key, a character is removed from the document. The Del key deletes a character in the current cursor position while backspace deletes the character to the left of the current cursor position and moves the cursor one position to the left.

(iv) Deleting a block of Text

Select the block of text to be deleted by dragging through the mouse. Then you can press Del key. Another method is to select Edit from the menu bar and then select clear.

(v) Moving Text

If you want to shift the text from one place to another in the document, you can do so by moving the text. Select the block of the text you want to shift. You can move the text using the toolbar, the menu bar or the drag function.

(vi) Using the Toolbar

After you select the text, click on the Cut button in the standard toolbar (the icon with
a scissors) and then bring the cursor to the new location where the text has to appear and click on the Paste button in the standard toolbar.

(vii) Using the Menu Bar
Select the text to be shifted. Choose the Cut option from the Edit menu. Bring the cursor to the new location where the text has to appear and then choose the Paste option from the Edit menu.

(viii) Using the Click and Drag Function
Select the text to be shifted. Click anywhere in the selected text and then drag it to the desired new location and leave it there.

(ix) Copying Text
If you want to copy the text from one place to another in the document, you need to make block of the text first. Select the block of the text you want to copy. You can copy the text using the toolbar, the menu bar or the drag function.

5.8 USING THE TOOLBAR
After you select the text, click on the Copy button in the standard toolbar and then bring the cursor to the new location where the text has to appear again and click on the Paste button in the standard toolbar as shown in the Fig. 5.3

(i) Using the Menu Bar
Select the text to be copied. Choose the Copy option from the Edit menu. Bring the cursor to the new location where the text has to appear and then choose the Paste option from the Edit menu.

(ii) Using the Click and Drag Function
Select the text to be copied. Click anywhere in the selected text and then-drag into the desired new location and leave it there.

(iii) Deleting a Block of Text
Select the text to be copied as a block and then either you can press the Del key or you can select the Clear option from the Edit menu.

5.9 UNDO-REPEAT
Many times, it is required to undo previous command and also to repeat previous actions. For this you can use the undo and redo options of the edit menu. Undo reverses the changes made in a document.
INTEXT QUESTIONS 5.1

1. State True or False
   (a) To open a file, you can type in Alt + F.
   (b) Instead of clicking File and New you can directly open a new document by clicking at the ‘new’ icon on the standard tool bar.
   (c) While deleting a text the need may arise to move a block of text from one place to another.
   (d) By pressing either the backspace or the Del key a character is removed from the document.

5.10 FIND AND REPLACE TEXT

It is a very standard and powerful feature of any word processor. Ms-Word gives a facility using which any word or text can be searched throughout the document and it can be replaced with the required word or text. To find and replace text, click on Edit from the menu bar. A dialog box as shown in the Fig. 5.4 will be displayed.

![Fig. 5.4 Replacing Text](image-url)
Following steps are to be followed to execute Find and Replace command.

- Type the text to be searched. For example, we type NOS if we have to find it.
- Click on Find Next. (This will allow you only to find a text, not to replace it with something else.)
- Click at Replace on the top left hand corner. (You will find another box where you can type the text which will replace the existing text)
- Type the text, which will replace the text.
- Click on Replace or Replace All, as per the requirement.
- Click on close to resume editing.

5.11 SAVE AND EXIT

When you are finished with your document, it will not be stored automatically. In order to save the document on to the disc for future use, you have to click on File from menu bar, and then selecting Save option (Fig. 5.5).

![Microsoft Word - Document3](image)

**Fig. 5.5** Saving a document

When you save a document for the first time you have to click at **Save As**. You will find a dialog box as in Fig. 5.6.
Here you have to specify the file name, the directory and the drive in which the document has to be saved. In Fig. 5.6, the file is saved in directory ‘unitrev’, the file name is ‘m2’ and it is saved as a word document. Remember that Ms-Word offers scope to save your file in different modes such as text only, word perfect, earlier versions of Ms-Word, etc. Once you have specified the file name, directory, and document type, you have to click at Save.

(a) Auto saving a Document

When you are working with a document, Ms-Word can save your document, periodically. You have to choose the option of Auto save and its period also. You can enable the Auto save by clicking on Tools from the menu bar and then selecting the Options option. Select the Save button from the dialog box as shown in the Fig. 5.7.
Once you click at Save you will find a screen as given in Fig. 5.8. Here you can specify the time (in minutes) when you want Ms-Word to auto-save the document. In the Fig. 5.8 the time is adjusted to 5 minutes. This means that for the file 'm2.doc' the computer will save automatically every 5 minutes. The advantage of auto-save is that in case of a power failure, the work lost is at most of 5 minutes.

(b) Saving with a Password

At times, you do not want your important documents to be opened by others. Ms-Word offers you the scope of providing a password to open the file. As you can see from Fig. there is a separate box where you can type in the password you want to give. Ms-Word will show an asterix (*) for every alphabet or number. In Fig. 5.8 we have given a password 'GHXT', hence the 4 asterixs. Remember that while assigning a password Ms-Word distinguishes between loewr case and capital case. So you cannot open a file with password GHXT by typing in 'ghxt'.
5.12 OPENING AN EXISTING DOCUMENT

In order to open an existing document you can click on File from menu bar and then choose the Open option. The open file dialog box will be displayed as shown in the Fig. 5.9.
Here you can select the directory and the drive from where you have to open the document and then selecting the file name from the file list box and then click on the OK option to open the document.

You can also click on the Open File tool from the standard toolbar to open a document. This will also display the same ‘open file dialog box’ from where you can use the similar steps to open a document.

5.13 QUITTING WORD

Once you are finished with your work you need to exit from Ms-Word. This you can do by clicking on the File from the menu bar and then selecting the Exit option. If the document is not currently saved Ms-Word will ask whether to save the file or not by displaying the following dialog box (see Fig. 5.10). You have to click on the option Yes to save the changes. Once you come out of the Word, the Windows screen will be displayed and there you can continue to work on windows or you can exit from Windows and switch off your machine. However, do not switch off your machine without exiting from Ms-Word, this may result in loss of valuable data.
INTEXT QUESTION 5.2

1. Choose the best answer
   (a) To find and replace text, click on
       (i) Edit
       (ii) File
       (iii) View

   (b) When you save a document for the first time you have to click at
       (i) Save
       (ii) Rename
       (iii) Save as

   (c) In order to open on existing document you can click on
       (i) File
       (ii) Edit
       (iii) View

5.14 WHAT YOU HAVE LEARNT

At the end of this lesson you learnt the procedure of creating a new document. Now you are in a position to start typing on the new document and make corrections for the error. Ms-Word can delete a character, word, line or paragraph and replace with required text. Also you can move the selected part of the text to another place by the “cut” and “paste” commands. At the end of the lesson discussed the procedure of saving a document and exit out of Ms-Word.

5.15 TERMINAL QUESTIONS

1. Describe the steps to open a new document.
2. Explain the steps to find the word ‘NOS’ and replacing it by ‘National Open School’.
3. List steps to save a document.
4. How will you open an existing document for editing?

5.16 FEEDBACK TO INTEXT QUESTIONS

INTEXT QUESTION 5.1

1. (a) True  (b) True  (c) False  (d) True

INTEXT QUESTION 5.2

1. (a) i  (b) iii  (c) i
6

FORMATTING A DOCUMENT

6.1 INTRODUCTION
By now you have learnt the process of entering text into a document and editing it for mistakes. The next step is to design the document in a proper format so that it is presentable. The setting of margins, spacing between lines, size of letters, etc. are some of the basic requirements of a good presentation.

6.2 OBJECTIVES
At the end of the lesson you should be able to:
- change character formats such as fonts and size and its appearance by making them bold, italic, underlined, etc.
- format documents in terms of line spacing, alignment, etc.
- apply borders and shading to the paragraphs.
- create bulleted and numbered lists

6.3 DEFAULT AND CUSTOMIZED FORMAT
There are two ways of formatting a document. One way is to use the MS-WORD Auto format where MS-WORD analyzes the selected texts and it applies the relevant formats. Alternatively you can also format each and every element such as character, margins, etc. yourself by choosing customized formatting.

(a) Auto Formatting
After typing a document, you can choose the Autoformat option from the format menu to make the Ms-Word format the text in a default style. Perform the following steps for Auto formatting of text:
- Select the text that is to be formatted by dragging the mouse.
- Choose Autoformat from the format menu.
  Ms-Word analyses the text and applies the relevant formats
A dialog box appears as shown in the Fig. 6.1 after choosing Autoformat where one has to click OK button for default formatting.

Fig. 6.1 Auto Format.

6.4 CHARACTER FORMATTING

You should note that formatting the character means changing the font, size and colour of the text. It also includes the appearance of character by changing the font styles. Characters can be formatted by

- Pressing the Shortcut keys
- By choosing the Font command from the Format menu
- Clicking the desired button on the Formatting toolbar

Select the text where you want to change the font. On selecting the Font from the Format menu bar, the following dialog box will be appeared as shown in Fig. 6.2.
Fig. 6.2 Changing Font, Size and Color of the Text

You can choose the appropriate font from the list box. Some of the examples of different fonts are given below:

```
National Open School is in Times New Roman font
National Open School is in Courier New
National Open School is in Bookman Bold
```

Fig. 6.4

You can also select a font size from the size list box. Some of the examples of different font point size are given below:

```
National Open School is in point size 12.
National Open School is in point size 16.
National Open School is in point size 18.
```
You can select a color for the text from the colour list box. Some of these functions can also be achieved through clicking at the appropriate icon in the Formatting toolbar. You now that when you place the mouse over an icon, the name of the icon comes out. So choosing the appropriate icon from the Formatting tool bar should not be a problem for you.

(i) **Boldface**

Select the text you want to have boldface and click on the Boldface button from the Formatting toolbar.

![Image of Microsoft Word formatting options]

NOS is in **Boldface** style

(ii) **Italics**

Select the text you want to have italics and click on the Italic button from the Formatting toolbar.
(iii) Underline
Select the text you want to have underline and click on the Underline button from the Formatting toolbar.

Boldface, Italics and Underline button toggle between on and off. When you want to remove boldface, italics or underline, you can select the text again and click on Boldface, Italics or Underline button to remove it.

(iv) Subscripts and Superscripts
You can add subscripts and superscripts to your typed text. First, highlight the text to be shown as subscript or superscript. Second, click at formal, font and subscript/superscript.

Examples:

<table>
<thead>
<tr>
<th></th>
<th>Superscript</th>
<th>40th</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscript</td>
<td>B_i</td>
<td></td>
</tr>
</tbody>
</table>

(v) Drop Caps
As you can see from Fig. 6.6 Ms-Word offers a lot of options to design your text. In addition to ‘All caps’ and ‘small caps’ options from the ‘Font’ dialog box, you can also use ‘Drop caps’ to decorate your text.

![Drop Cap](image)
6.5 LINE SPACING

Once the characters have been formatted as per your desire, you can adjust the spacing between the lines according to your requirement. Click on Format and select Paragraph option from the menu bar. A dialog box as shown in the Fig. 6.7 will be displayed.

![Fig. 6.7 Line Spacing](image)

You can select Single or Double line spacing as per requirement. A sample text of different line spacing is given below.

**Single Line Spacing**

National Open School is an autonomous organisation under Deptt. of Education, MHRD. It was established in 1989. NOS offers Secondary and Senior Secondary level courses through distance education mode. Besides these courses, NOS also offers various vocational courses. It also offers basic education at elementary level.

**Double Line Spacing**

National Open School is an autonomous organisation under Deptt. of Education, MHRD. It was established in 1989. NOS offers Secondary and Senior Secondary level courses through distance education mode. Besides these courses, NOS also offers various vocational courses. It also offers basic education at elementary level.
6.6 ALIGNMENT

By default, Ms-Word aligns all the text as left aligned. However, you can make the text aligned at right or centre aligned also.

(i) Left-aligning Text
First select the paragraph you want to align and then click on the Left Align Tool from the Formatting toolbar as shown below.

![Fig. 6.8 Left Align Tool]

You can also select the Format from the menu bar and then select the paragraph option. From the Alignment drop-down line you can choose the Left option to get the desired effect of left-justified paragraph.

(ii) Right-aligning Text
First select the paragraph you want to align and then click on the Right Align Tool from the Formatting toolbar as shown below.

![Fig. 6.9 Right Align Tool]

You can also select the Format from the menu bar and then select the paragraph option. From the Alignment drop-down line you can choose the Right option to get the desired effect of right-justified paragraph.

(iii) Centre-aligning Text
First select the paragraph you want to align and then click on the Centre Align Tool from the Formatting toolbar as shown below.

![Fig. 6.10 Centre Align Tool]

You can also select the Format from the menu bar and then select the paragraph option. From the Alignment drop-down line you can choose the Centre option to get the desired effect of right-justified paragraph.

(iv) Justification
After aligning the text, you may like to justify the whole paragraph. For justifying the text, select the paragraph of the text and click the Justification Tool from the Formatting toolbar as shown below.

![Fig. 6.11 Justification Tool]
INTEXT QUESTION 6.1

1. State 'True' or 'False'.
   (a) Formatting the character means changing the font, size and colour of text.
   (b) You cannot add subscripts and superscripts to your text.
   (c) By default Ms-Word aligns all the text as left aligned.
   (d) For justifying the text you have to select the paragraph of the text and click
       the justification tool from the formatting toolbar.

6.7 BORDERS AND SHADING

You can add borders and shading to your paragraph for highlighting your text.

(a) Borders

Borders can be drawn around the entire page, around all paragraphs or around specific
paragraph. You can apply borders using the Borders toolbar from the menu bar as shown
in the Fig. 6.12.

Fig. 6.12 Borders Toolbar
You can click on the appropriate Border icon from the Border toolbar to apply a top border, or a bottom border, a left border, a right border, or an outside border. The following table describes the proper clicking of the Borders toolbar. Do one or more of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a border to the top of a paragraph.</td>
<td></td>
</tr>
<tr>
<td>Add a border to the bottom of a paragraph.</td>
<td></td>
</tr>
<tr>
<td>Add a border to the left of a paragraph.</td>
<td></td>
</tr>
<tr>
<td>Add a border to the right of a paragraph.</td>
<td></td>
</tr>
<tr>
<td>Add a border between paragraph or add a border inside a paragraph.</td>
<td></td>
</tr>
<tr>
<td>Add a box border to selected paragraph.</td>
<td></td>
</tr>
<tr>
<td>Remove all borders.</td>
<td></td>
</tr>
</tbody>
</table>

The thickness of the borderline can be changed by clicking on the down arrow of the drop down list box and selecting the desired thickness.

(b) **Shading**

You can apply shading to your paragraph of text to make it more prominent or to highlight your text. The shading level can be controlled by using the Shading tool available in the Borders toolbar. Select the paragraph you want to give shading and then click on the drop-down list of the Shading style and choose a shading type as shown in the Fig. 6.13.
Alternatively, you can use the Borders and Shading option from the Format menu bar. The following dialog box will appear as shown in the Fig. 6.14.

To change the color of the border by choosing the desired color from the Color dropdown list box. You can select the different thickness of the border from the Style list.
6.8 PAGE BREAKS

As you work on a document, Ms-Word starts a new page automatically when the current page is full. These page breaks are called automatic or soft page breaks. To insert and remove Hard page breaks, also called user defined page breaks, bring the cursor to the insertion point where you want the page break. Choose Break from the Insert menu bar or Press [Ctrl+Enter]. In a similar way you can remove an existing page break by pressing backspace or delete key.

6.9 COLUMNS

Multiple columns make a document more appealing and sometimes it is requirement of the document also as the case of newspapers and magazines where texts appear in multiple columns. Text runs down the left most columns to the bottom of the page, wraps to the top of the next column, continues to the bottom of the page and then wraps either to the top of the next column or if it has filled the last column on the page, to the leftmost column on the next page. Text flows from the bottom of one column to the top of the next column.

You can create the desired number of columns before typing out the text or it can be done even after you are finished with typing the text. In order to create the column, click the Column button on the Formatting toolbar and drag to select the number of columns as shown in the Fig. 6.15.

![Microsoft Word - Document1](image.png)

Fig. 6.15 Column selection
This will create columns of equal width. You can also select the Columns from the Format menu bar. The following dialog box will appear as shown in the Fig. 6.16.

From the dialog box, you can select one/two or three of equal width or you can select left or right presets. The left preset makes the left column narrower than the right and the right preset makes the right column narrower than the left.

You can also adjust the exact width and spacing of the column by seeing the preview in the side box.

You can have a line divider between the column by clicking Line Between button in the box to make your text more decorative.

You can create columns of different width as per your choice or requirement by disabling the ‘Equal Column width’ button in the box and then specifying the different width and spacing for different columns.

You can also insert or remove a column at a later stage. To insert a column break, choose the Break from the Insert menu bar. To remove a column, you can just select the required number of column, which align the text in the required number of column.

6.10 CHANGING CASE

Sometime you are required to change the case of your text due to typing mistakes. Ms-Word provides five different types of text case, which you can choose as per your requirement. Highlight the paragraph of text you want to change the text case and then click Change case from the Format menu bar. The following dialog box will appear as shown in the Fig. 6.16.

![Change Case Dialog Box](image)

The following five different types of text case are shown in the dialog box.
(i) Sentence case
By choosing this option first character of every sentence will be capitalized and the remaining character will remain unchanged.

(ii) Lower case
By choosing this option all characters of the selected text will be converted into small case.

(iii) Upper case
By choosing this option, all characters of the selected text will be converted into upper case.

(iv) Title case
By choosing this option, the first character of every word of the selected text will be converted into upper case.

(v) Toggle case
By choosing this option, all characters in lower case will be converted into upper case and all characters in upper case will be converted into lower case.

6.11 ADDING AND REMOVING NUMBERS AND BULLETS

At times you are required to highlight some of the points of your documents in a list format. Your document may contain list of items which you would like to call attention to, such items can be numbered or bulleted. This improves the organization and appearance of the document.

(a) Adding Numbers and Bullets
To add numbers to specific paragraph, select Format from the main menu and then on Bullets and Numbering. A dialog box will appear as shown in the Fig. 6.17.
In order to assign a numbered style you have to select numbered. By default, the bulleted list is displayed. In order to select a bullet style from the dialog box and click on OK to get the new bullet style to the selected text.

Remember that when you add text to the list, the text will also get numbered or bulleted as the case may be.

(b) Removing Number and Bullets

When you want to remove the numbers or bullets, highlight the text again and click on the Number tool or Bullet tool from the formatting toolbar. In the list, if the number or bullet has to be ignored for a particular line of text, then press Shift and Enter instead of pressing only Enter.

INTEXT QUESTION 6.2

1. State whether ‘True’ or ‘False’
   (a) Boarders cannot be drawn around the entire page.
   (b) MS-Word starts new page automatically when the current page in full.
   (c) In order to create a column, click the column button on the formatting tool bar and drag to select the number of column.
   (d) The left-present makes the the right column narrower than the left column.
   (e) MS-Word provides five different types text case which you can choose as per your requirements.

6.12 WHAT YOU HAVE LEARNT

In this lesson you learnt the preliminary concepts in formatting a document. Now you should be in a position to design your document in the required format. You should be in position to apply margins, change the font size of letters, make the letters bold face or italic and justify the text. Also you have learnt the procedure of applying boarders and shading with different colour.

6.13 TERMINAL QUESTIONS

1. Explain the different types of alignment available in Ms-Word.
2. Explain various types of borders and steps to put them.
3. Describe the steps for setting line spacing
4. How will you insert a page break?
5. How do you create columns?
6. List steps for creating bulleted list.

6.14 FEEDBACK TO INTEXT QUESTIONS

INTEXT QUESTIONS 6.1

1. (a) True  (b) False  (c) True  (d) True

INTEXT QUESTIONS 6.2

1. (a) False  (b) True  (c) True  (d) True  (e) True
ADVANCED FORMATTING

7.1 INTRODUCTION

Besides the preliminary format functions Ms-Word offers some advanced features which you will find useful. The concepts of providing a header or footer to the text, inserting a table and printing a document are necessary jobs of word-processing.

7.2 OBJECTIVES

At the end of the lesson you should be able to format a page using the following features of Ms-Word:

- tab setting
- indenting
- margins
- header and footer
- spell check a document
- create and manage a table
- preview and print a document

7.3 TAB SETTING

Tab setting is basically a text alignment tool available in Ms-Word. Tab stops are certain pre-specified column positions as shown in the ruler line by "1", "2", etc. Pressing the Tab key can directly access each of these positions on any line.

You can align text and number at a tab stop left, right, centered aligned or justified. In order to set tab stop, first select the paragraph and then select the Tab option from the Format menu bar. The following dialog box will appear as shown in the Fig. 7.1.
From the dialog box you can specify the Tab stop, choose the alignment and then click on the OK button to get the desired effect. In a similar way, you can choose the clear all option from the dialog box for clearing the tab setting.

Alternatively, you can use the drag feature of tab pointers on the ruler line for setting the desired tab stops.

7.4 INDENTING

You can use indenting to mark a clear distinction to a line or paragraph from rest of the text. In order to indent your text select the paragraph of text and then click the **Paragraph** option of the **Format** main menu. The following dialog box will appear as shown in the Fig. 7.2.
Fig. 7.2 Indenting Paragraph

From the dialog box you can specify the left and right indentation as per requirement and then click OK to get the desired effect. Alternatively, you can drag the indent marker on the ruler for indenting the paragraph.

7.5 MARGINS

You can set the margins of a page using the Ruler bar. It can also be adjusted by clicking on the margin boundary and dragging it to the desired margin as shown in the Fig. 7.3
You can also set the margins by choosing the **Page Setup** from the File option at main menu. The following dialog box will appear as shown in the Fig. 7.4

![Microsoft Word Page Setup dialog box](image)

**Fig. 7.4 Margin Setting**

From the dialog box you can specify the Top, Bottom, Inside and outside margins. The new settings for the margins can be applied either to the whole document or a particular section of the document. Selecting the required option from the drop-down list of Apply To does this.

### 7.6 HEADER AND FOOTER

A **Header** is text that appears automatically at the top of every page in a document, and Footer is text that appears automatically at the bottom of every page of the document. The Headers and Footers also get printed on every page of the document. It is a very powerful tool of Ms-Word and is used extensively.

Headers and Footers can be invoked by clicking on View from the menu bar and then selecting the Headers and Footers option.

A dotted box is provided for entering the Headers to be appeared at the top of every page.
After typing the text for Header you can switch to the footer area by clicking on the Switch between Header and Footer tool from the Header and Footer Toolbar as shown in the Fig.

You can use the Header and Footer toolbar buttons to insert the page number, the current date, or the current time into your Header or Footer.

To insert page numbers, click on the Page number tool in the Header and Footer toolbar.

To insert the date, click on the Date tool in the Header and Footer toolbar as shown in.

To insert the time, click on the Time tool in the Header and Footer toolbar as shown in.

7.7 SPELL CHECKING THE DOCUMENT

When you are typing, you are bound to make mistakes. Spell check is a powerful feature of Word, which helps you correct spelling mistakes. Ms-Word checks a document using its main dictionary, which contains most common words. You can also create your own custom dictionary. You can invoke the Spell check by clicking on the Spell check tool from the Formatting toolbar as shown in the Fig. 7.6

You can also invoke Spellchecker by selecting the spelling option from the Tools menu. The spellcheck feature verifies the whole document and displays a dialog box whenever it encounters an error as shown in the Fig. 7.7
Fig. 7.7, Spelling Dialog Box

For each word displayed in the ‘Not in Dictionary’ box, a list of suggestions to correct the mistakes is also displayed in the Suggestions box. Select any one of them and click on Change to change the mistake in the document. You can select any one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Click on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the spelling in the Change to box, replace the misspelled word with another from the suggestion box, or replace the misspelled word with the word you type in the Change To box.</td>
<td>The Change button.</td>
</tr>
<tr>
<td>Replace all instances of the word.</td>
<td>The Change All button.</td>
</tr>
<tr>
<td>Add the word to the Custom dictionary selected in the Add Words To box.</td>
<td>The Add button.</td>
</tr>
<tr>
<td>Display a list of proposed words.</td>
<td>The Suggest button.</td>
</tr>
<tr>
<td>Leave the word unchanged.</td>
<td>The Ignore button</td>
</tr>
</tbody>
</table>
Leave the word unchanged in all document. The Ignore All button.
Add the misspelled word and its correction to the Auto-correct list. The AutoCorrect button.
Customise spelling checks. The Option button.

**INTEXT QUESTION 7.1**

1. State whether ‘True’ or ‘False’.
   
   (a) You can align text and numbers at a tab stop left, right, centre or justified.

   (b) In order to indent your text you have to select the paragraph option of the format main menu.

   (c) A header is text that appears automatically at the bottom of every page in a document.

   (d) Footer sets the margin by choosing the page setup from the file option.

   (e) The option button customises spelling checks.

7.8 CREATING AND MANAGING TABLES

Sometimes you are required to present data and information in a tabular form while preparing any reports along with the text. Ms-Word provides a special feature called Table which helps you present the information in a tabular form.

(a) Creating a Table

You can create a table into your document using the Insert option from the Table menu. Place the insertion point where you want to insert the table and then select Insert Table after clicking on Table from the menu bar. The following dialog box will appear as shown in the Fig. 7.8.

![Insert Table Dialog Box](image)

**Fig. 7.8** Inserting a Table
From the box you can specify the number of columns and rows and then click on OK to insert the table. The following structure will be displayed if you specify number of columns at 3 and number of rows at 3.

A table consists of vertical columns and horizontal rows as shown above. The intersection of a column and a row is called a cell. Gridlines are displayed between the cells.

You can also create a table by clicking on Insert Table button from the formatting toolbar. In this case you need to drag on the Insert Table button grid to specify the number of columns and rows.

(b) Entering text into Table

After creating a Table at the desired place, you can enter the text by clicking on any of the cell. The Tab key can be used to move to the next cell. Within each cell, the text wraps just like it does in a given column. The cell expands vertically to fit the text entered.

(c) Modifying Table

After you have created your table or even after you have entered your data into the table, you can still perform various operations on the table, which are described below:

(i) Inserting Rows and Columns

To insert a row at the end of a table, bring the cursor to the last cell and Press the Tab key. To insert a row within a table, bring the cursor to the row before which the new row has to appear and then select Insert Row option from Table menu bar. A new row will be inserted before the selected row.

To insert a column, select the Column option from the Table menu and then select the Insert Column option. A new column will be inserted to the left of the selected column.

(ii) Deleting Rows and Column

To delete one or more contiguous rows in a table, select the row(s) that you want to delete and then select Delete Rows from Table menu.

To delete one or more contiguous columns, select the column(s) that you want to delete and then select Delete Columns option from the Table menu.

To delete an entire table, select the table and then choose Delete Rows option from the Table menu.

(iii) Changing Column Width

To change column width, point the column boundary that you want to change, the mouse pointer will become a horizontal double headed arrow. Then drag the column boundary to the desired width and then release the mouse button.
You can also change the column width by selecting the Column and then selecting the option Cell Height and Width from Table menu. Enter the desired width in the Width of Column text box and click on OK to change the column width of the selected column.

(iv) Changing Row Height

To change height of a row, point the row boundary that you want to change, the mouse pointer will become a vertical down headed arrow. Then drag the row boundary to the desired height and then release the mouse button. You can also change the column width by selecting the Row and then selecting the option Cell Height and Width from Table menu. Enter the desired height in the Height of Row text box and click on OK to change the row height of the selected row.

(d) Sort

Using this option any column of the table can be sorted either on ascending or descending order. This is applicable only for the numerical values in the cells of the table.

(e) Formula

Besides text, there can always be numerical values in the cells of the table. For numerical values you may like to apply the different mathematical operations. Using the ‘Formula’ feature of MS-WORD you can calculate the values and put it at the proper place. The following example shows the application of Formula feature.

<table>
<thead>
<tr>
<th>Year</th>
<th>Bridge</th>
<th>Secondary</th>
<th>Sr. Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1995</td>
<td>2000</td>
<td>40000</td>
<td>30000</td>
</tr>
<tr>
<td>1996</td>
<td>1500</td>
<td>42000</td>
<td>32000</td>
</tr>
<tr>
<td>1997</td>
<td>1700</td>
<td>45000</td>
<td>35000</td>
</tr>
</tbody>
</table>

Table - 1 shows the year wise enrolment of students in different courses.

<table>
<thead>
<tr>
<th>Year</th>
<th>Bridge</th>
<th>Secondary</th>
<th>Sr. Secondary</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1995</td>
<td>2000</td>
<td>40000</td>
<td>30000</td>
<td>72000</td>
</tr>
<tr>
<td>1996</td>
<td>1500</td>
<td>42000</td>
<td>32000</td>
<td>75500</td>
</tr>
<tr>
<td>1997</td>
<td>1700</td>
<td>45000</td>
<td>35000</td>
<td>81700</td>
</tr>
<tr>
<td>Total</td>
<td>5200</td>
<td>127000</td>
<td>97000</td>
<td>229200</td>
</tr>
</tbody>
</table>

Table - 2

There could be requirement to illustrate the total of the enrolment for each year as well as cumulative enrolment.
7.9 PREVIEW AND PRINTING A DOCUMENT

By default, Ms-Word prints one copy of the entire document. Printing can be done to a file also which is called print file. Printing a document is a three-step process, namely

- Connecting a printer
- Selecting or installing the printer
- Printing a document

The first two steps are done only once. The printer is connected through a cable to the computer. Choose the Print option from the File menu. The following dialog box will appear as shown in the Fig. 7.9

Choose the Printer button and select the printer you want to use. If you do not see your printer listed in the box, you must install printer driver first.

The third step, printing a document is then executed after you specify the printing option. Before you actually print a document you can preview the document as it will look when printed and allow you to make final adjustments to the layout.
From the Print dialog box, you can specify the number of copies to print and also the page range to be printed. You can specify the page numbers separated by commas or a range of pages with a hyphen between the page numbers. For example 2, 4, 6, 7 or 3-7. You can also click on the Print tool from the standard toolbar.

7.10 PRINTING TO A FILE
When you print a document, instead of printing on a printer, you can redirect it to a file which is called a print file. You can do so by enabling the Print to File option from the Print dialog box and then mention a name of the print file.

INTEXT QUESTION 7.2
1. State whether ‘True’ or ‘False’
   (a) You can create a table into your document using the insert option from the table menu.
   (b) The intersection of column and row is called a table.
   (c) To delete entire table you have to select the delete rows option the table.
   (d) Using formula feature of Ms-Word you can calculate the values and put it at proper
   (e) By default, MS-Word prints five copies of the entire document.

7.11 WHAT YOU HAVE LEARNT
At the end of this lesson you have learnt some of the advanced features available in Ms-Word. By now you should be in a position to apply header or footer to the document. Also you should be able to set the tab and the indent to make the document presentable. In this lesson we discussed the procedure of inserting a table in the document. You can insert a table of required number of rows and columns by now. You have also learnt the procedure of previewing a document before printing and taking a final printout of the document.

7.12 TERMINAL QUESTIONS
1. How do you set margins for your document?
2. List steps to create a header and footer for your document.
3. How do you invoke Spell Check feature for your document?
4. Describe the steps to create a table.
5. Explain the process of printing a document.

7.13 FEEDBACK TO IN-TEXT QUESTIONS
INTEXT QUESTIONS 7.1
1. (a) True   (b) True   (c) False   (d) False   (e) True

INTEXT QUESTIONS 7.2
1. (a) True   (b) False   (c) True   (d) True   (e) False
8
MAIL MERGE

8.1 INTRODUCTION

The Mail Merge feature has been described here. In Ms-Word Mail Merge option is an important and every way for office set up. Many times we required sending the same content of a letter to different individuals. By using Mail Merge you can send the same letter to a number of persons without typing the content of the letter again and again.

8.2 OBJECTIVES

At the end of the lesson you should be able to:
- understand the concept of Mail Merge
- create a main document
- create a data source
- link the main document with the data source
- merge print a document

8.3 WHAT IS MAIL MERGE?

In any working environment, there are situations when a similar type of letter or document is to be sent to many persons who reside at different locations. The letters may contain the address of each recipient, in addition to the standard information contained in the letter. One way of doing this is to print the letters by changing the address each time in the document after printing such letter. But this would mean lot of effort and time and also results in bad organisation.

Such problems are taken care of by the Mail Merge facility. In word processing, Mail Merge is the process of transferring selected information from one document to another document.

8.4 CONCEPT OF MAIL MERGING AND ITS COMPONENTS
- Mail Merge is the facility which requires the following three information
- General body of the letter called main document
- Header Row, the record structure or the name of the fields, which will identify the data

Data for all the individuals, for whom the letters are to be generated also called data source. Mail Merge option of Word reads this data and physically merges it with Main document to generate letters for all the persons or for all records in the data file.

![Diagram](image.png)

(a) Main Document

In Mail Merge, Main Document is the common letter, which contains the common information for each of the merged document. It also contains the field names, which contain the instructions for carrying out the merge.

(b) Data Source

Data Source is also called the Data File. It stores information to be brought into the Main document. The data file table contains a column for each category of information, or data field, in the data file. The Header Row is the first row of the table. It contains field names, which indicate the type of information in each column. For example list of names and addresses.

Each field name must be unique and must begin with an alphabet/letter.

(c) Form Letter

Form letter is the resultant document of the mail merge operations, which contains the copy of the main document along with each piece of information stored in the data file.

### INTEXT QUESTIONS 8.1

1. What do you mean by Mail Merge?
2. What are the three information required for Mail Merge?
3. Define Form Letter.

### 8.5 MAIL MERGE OPTION OF WORD

Thus by now it is clear that for Mail Merge document, you need to

- Create the main document
- Create data source
- Merge the data with document
All these operations can be performed by Mail Merge option of WORD. In order to invoke the Mail Merge option, choose the Mail Merge option of the Tools menu. The following Mail Merge Helper box will appear as shown in Fig. 8.2.

Fig. 8.2 Mail Merge Helper

Mail Merge helper guides you through the steps of mail merging a document. There are three main options available in the box.

(i) Creating the Main Document

The first step in the mail merge is to create the main document. For this, choose ‘Create button of ‘Main Document’ option in Mail Merge Helper box. The following menu will be displayed:

- Form Letter...
- Mailing Labels...
- Envelopes...
- Catalog...
- Restore to Normal Word document
Now choose ‘Form Letters’ option from this menu as the type of main document. The following box will appear as shown in the Fig. 8.3.

Choose the Active Window button from the above box. Type the main document and again invoke the Mail Merge Helper.

(ii) Creating Data Source

Choose the ‘Get Data’ button from the Mail Merge Helper box. For creating data source, select Create Data Source. The following dialog box will appear as shown in the Fig. 8.4.
The field names are already available in the Header row, which are default fields for an address list. Any field that is not required can be removed, and any new field can be added. For removing a field, highlight that particular field and click on the ‘Remove field Name’ button. For adding a new field, type the name of the field in the Field Name box and then click on the ‘Add Field Name’ button.

Click on the OK button and save your data structure as well as the data source.

Click on the ‘Edit Data Source’ button from the box to enter records in the data file. A Data Form dialog box will be displayed.

Enter the records by typing in the boxes. For adding a record choose ‘Add New’ button. For removing a record, choose ‘Delete’ button. After you finish with adding records, click on the OK button.

(iii) Opening the Data Source

You can also use a data source already created. You can open it by clicking the ‘Get Data’ option in the Mail Merge Helper and then selecting ‘Open Data Source’. A dialog box will appear with a list of data source file names. Select the name of the data source to open it.
(iv) Merging the Text with Data

After creating the main document and data source, the third step is to merge the main document with the data source. For this, invoke the Mail Merge Helper again and choose the ‘Merge’ button.

Select ‘New Document’ from the ‘Merge To’ drop-down list and click on ‘Merge’ button. The form letters are generated and stored in the document which may be previewed for final adjustment in the main document, before printing the for letters.

8.6 MERGE PRINTING

You can directly print the Form Letters without previewing them. Select the Printer option, then the form letters are directly printed on the printer.

8.7 CONDITIONAL MERGING

You can also mail merge the document with a condition. There are two options available in the Merge dialog box, i.e., ‘Merge’ and ‘Query Options’ options. Using Query Option you can define the selection criteria so that at the time of merging only those records are selected which meet the defined selection criteria.

INTEXT QUESTIONS 8.2

1. State whether the following statement is True or False

   (a) For mail merge document, you need to create the main document.

   (b) To create Data Source choose the get data button from the mail merge helper box.

   (c) For adding new field, type the name of the field in record name box.

   (d) After creating the main document and data source, the third step is to merge main document with the data source.

   (e) You can directly print the form letters without previewing them.

   (f) Merge and query are two options available in merge dialog box.

8.8 WHAT YOU HAVE LEARNT

After going through this lesson you have learnt the concept of mail merge and its usefulness. The mail merge feature of MS-Word requires mainly two components: the main document is the body of the letter that has to be sent. The data file contains the list of names and addressess in the form of fields. You have learnt the procedures of creating the main document and the data file, and combining them.

8.9 TERMINAL QUESTIONS

1. What do you understand by Mail Merge?

2. Define the different components of Mail Merge.

3. How do you invoke ‘Mail Merge Helper’ window?

4. Differentiate between Merge and Query option of ‘Mail Merge Helper’ window.
8.10 FEEDBACK TO IN-TEXT QUESTIONS

INTEXT QUESTIONS 8.1

1. The process of transferring selected information from one document to another document is known as Mail Merge.

2. Main Document, Data Source and Form Letter

3. Form letter is the resultant document of the mail merge operations, which contains the copy of the main document along with each piece of information stored in the data file.

INTEXT QUESTIONS 8.2

1. (a) True (b) True (c) False (d) True (e) False (f) True
Sample Question Paper:
Senior Secondary Level
Word Processing (Ms-Word)

Maximum Marks 40,

(Answer all the questions)

1. Fill in the blanks (½ × 10)
   i) Ms-word is a _______ based word processor.
   ii) Ms-office contains Ms-Excel, Ms-Access, _______ & _______.
   iii) The _______ bar allows you to format the vertical alignment of
text in a document.
   iv) The _______ bar displays information about the currently
active document.
   v) In Ms-word, Table contains _______ & _______.
   vi) _______ is text that appears automatically at the bottom of every
page of the document.
   vii) By default, Ms-word prints _______ copies of the entire
document.
   viii) _______ is an input unit.
   ix) _______ & _______ are jointly known as CPU.
   x) Windows’95 provides greater _______ compatibility as compare
to other operating environment.

2.(a) Multiple choice(½×5)
   (i) While working in Ms-word you have to work with _______.
      (a) Mouse only    (b) Key-board only
      (c) Both Mouse & Key-board (d) None of the above.
   (ii) By choosing _______ case option the first character of every
word of the selected text will be converted into upper case.
      (a) Toggle case    (b) Title case
      (c) Upper case    (d) Sentence case.
   (iii) A _______ is a text that appears automatically at the top of
every page in a document.
      (a) Footnote    (b) Top note
      (c) Top margin   (d) None of the above.
   (iv) _______ is the resultant document of the mail merge
operations, which contains the copy of the main document along
with each piece of information stored in the data file.
      (a) Main document    (b) Form letters
      (c) Data source    (d) None of the above.
   (v) You can write a letter to your friend by the help of _______.
      (a) Ms-word    (b) WordStar
      (c) Word-perfect    (d) All the above.
(b) Match the following (1 × 5)
   
   (A)  
   1) Drop cap  
   2) Mail-Merge  
   3) Undo  
   4) Auto Save  
   5) Save As  

   (B)  
   i) Helps in sending the same letters to different person.  
   ii) Reverses the change made in a document.  
   iii) Use for making the first letter bigger.  
   iv) Saves the document after a fixed interval of time.  
   v) To make a duplicate copy of the file with some other name.  

3. State True or False (½ × 15)
   
   i) Word Processor is a software package that enables you to Create, Edit, Print & Save document.  
   ii) Word has the facility of Macros.  
   iii) Word does not allow the user to mix the graphical pictures with text.  
   iv) Once a action taken in Ms-Word can’t be change.  
   v) After completing a document a word can be replaced by another word.  
   vi) Simple mathematical calculations cannot be done in Ms-word.  
   vii) After entering something in table a user cannot change it to text.  
   viii) Mail Merge is the process of combining a data-file with a document file.  
   ix) A user can copy a block of text from one place to another.  
   x) There is no difference between Save & Save As.  
   xi) A password to a file can be given in Ms-Word.  
   xii) After modifying a document template it cannot be saved with a same name.  
   xiii) You cannot add subscripts & superscripts to your text.  
  xiv) By default Ms-Word aligns all the text as left aligned.  
   xv) Borders cannot be drawn around the entire page.

4. Explain in brief (2 × 5)
   
   i) What do you understand by word-processing? Give examples.  
   ii) What are the important features of Ms-Word?  
   iii) List the various steps how will you select by the help of Mouse & Keyboard?  
        (a) A single line  
        (b) A paragraph  
        (b) Full document  
   iv) What is Mail Merge? Explain in brief.  
   v) What are the important components of the Ms-Word screen? “Or”  

   Explain the process how will you create a document in the Name of NOS?
5(a) Define the following (1 × 5)
   i) Footnotes
   ii) Auto text
   iii) Bookmark
   iv) Macro
   v) Ctrl + B

(b) Differentiate between (2½ × 2)
   i) Sentence case & Toggle case.
   ii) Merge & Query option in Mail Merge.